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AbstratTraditional projet planning tehniques and tools do not a�ord the �exibility neededto be e�etive in our modern, dynami environments. Although in the �eld of arti-�ial intelligene, planning has developed to take into aount unertainty and theneed to adapt to hange, there is little evidene of this in projet management. Inthis dissertation we examine the �elds of projet management and arti�ial intelli-gene planning, applying advanes in the latter to produe a new projet planningmethodology: Dynami Planning. We present planning software spei�ally devel-oped to support this new way of planning. Initial results of evaluating the newapproah are also presented, whih indiate that the new methodology is more �ex-ible and better for traking progress than traditional projet planning tehniques.Reommendations for further researh and development are also disussed.
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Some Thoughts on Plans�He who every morning plans the transation of the day and follows outthat plan, arries a thread that will guide him through the maze of themost busy life. But where no plan is laid, where the disposal of timeis surrendered merely to the hane of inidene, haos will soon reign.�Vitor Hugo (1802 - 1885)�In preparing for battle I have always found that plans are useless, butplanning is indispensable.� Dwight D. Eisenhower (1890 - 1969)

Figure 1: An Extreme Gantt Chart1
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Chapter 1IntrodutionProjet planning is an integral part of projet management, essential to ensure thatthe projet delivers its desired results on time, within budget and to spei�ation.The traditional approah to projet planning intends to speify exatly what needsto be done at any given time in the projet's lifeyle. This thorough approah seemslogial and appropriate, whih is why it is surprising that only a small number ofprojets are atually deemed to be suessful [The Standish Group, 2005℄.The key issue is that traditional projet planning does not take aount of the dy-nami environment within whih the projet exists. Unforeseen ourrenes add tothe work that must be arried out, or present opportunities to ahieve results fasteror more heaply. The dilemma for the projet manager is evident: if they spend toomuh time planning and replanning, they may fail to manage the projet properly.However, if they fail to adjust the plan to hanging irumstanes, it quikly beomesout-dated and useless.A similar problem exists in the �eld of arti�ial intelligene (AI) planning. In order toreate intelligent systems that an at independently, they must be instilled with theability to plan; a mehanism for hoosing an appropriate set of ations to ahieve theeventual goal. Again, however, if too muh time is spent analysing the situation andplanning, then by the time an appropriate plan has been derived, the environmentmay have hanged again, invalidating the plan.Sine both areas experiene similar problems, one might expet the researh in eaharea to be heading in similar diretions. In fat, the opposite is true. Most ofthe reent work in projet planning has foused on reative ways to fore projetmanagers and teams to follow the traditional proess. Very few researhers seem toquestion the validity of this approah at all. In AI planning the piture is quite di�er-ent. Here there has been a progression from lassial planning (where environmentsare assumed to be steady, preditable and hangeable only by diret intervention)through to approahes better geared for addressing �real world� problems (suh asnondeterministi environments).Reative Planning is a prime example of the latter approah, with a fous on helpingintelligent systems to hoose the most appropriate next ation. The short-term fousallows reative systems to reat quikly to hanging onditions, at the same time stillheading towards the eventual goal. 1



The original aim of this projet was to develop planning software to a�ord projetmanagers the same sort of �exibility as these reative systems. However, duringthe bakground reading for the projet, it soon beame apparent that there was noexisting projet planning methodology that a�orded this level of �exibility. The fousthus shifted to applying the reent advanes in AI planning to projet management,developing a new methodology for �exible projet management.The methodology that we present is Dynami Planning, whih draws on variousplanning approahes from both projet management and arti�ial intelligene disi-plines, as well as diret researh into the way that people atually use plans. In orderto evaluate the e�etiveness of this new planning paradigm, the Dynami Plannersoftware was developed. Our initial results indiate that Dynami Planning supportsmore �exible projet planning, as well as more e�etive progress traking.This doument is strutured as follows: the next hapter overs the bakgroundreading and researh into projet and AI planning, inluding a disussion of thesimilarities and di�erenes of the two �elds. In Chapter 3 we propose the newDynami Planning methodology. Chapter 4 is onerned with the development ofthe Dynami Planner and in Chapter 5 we present the results of our initial evaluationof the methodology, using this software. Finally, in Chapter 6 onlusions and furtherwork are presented.1.1 Projet Aims & ObjetivesThe aim of this projet is to develop a method for �exible projet planning and thendevelop software to support it, so that an initial evaluation of the methodology an bearried out.The objetives are as follows:
• Researh and ritique existing projet planning methodologies
• Researh and ritique arti�ial intelligene planning tehniques
• Develop a method for �exible projet planning
• Develop software to support this method
• Evaluate the e�etiveness of the �exible projet planning methodology, usingthe software
• Gain tehnial, aademi and managements skills:� Learn new programming language and gain experiene in appliation de-velopment� Gain experiene in aademi researh and writing� Develop an understanding of AI planning tehniques� Gain an in-depth understanding of projet planning and managementtehniques 2



Chapter 2Researh
2.1 IntrodutionBefore onsidering any new methodology that we might develop for �exible projetplanning, it is of ourse neessary to onsider the urrent state of the art. In thishapter we will �rstly examine projet planning and then the various plan represen-tations that are assoiated with existing approahes. We then go on to disuss AIplanning, inluding traditional lassial planning and more reent developments thataim to adjust to real world onditions.First, however, we should look at the purpose of plans. Agre and Chapman [1989℄suggest the way in whih plans are designed to be used is very important. There aretwo main models: Plan-As-Program and Plan-As-Communiation. Thinking of aplan as a program, the user of the plan is expeted to exeute it exatly � what theydo will be preisely de�ned by the plan. When a plan is used for ommuniation,then the ation taken is not presribed by the plan. Instead the plan is used as onefator in deiding what to do next.There is a world of di�erene between the two. When a plan is used as a set ofinstrutions to be exeuted, then far more detail is required than in a plan intendedfor ommuniation. This is beause every eventuality needs to be predited andplanned around, beause all ations depend on the plan. Plans-As-Program alsoneed to be extremely preise, again beause the user is presumed to be unable todeal with unertainty or diversion from the plan.Plans-As-Communiation an a�ord to be muh less detailed and preise. Plansintended for ommuniating need only guide ations, sine the plan itself will onlybe used as one input to the deision of what ation to take. This absolves the plannerof the need to predit the future � the identi�ation of every eventuality requiredby the Plan-As-Program model. However, Plans-As-Program may also suumb tofragility and too muh detail, unless the planner aepts that perfet ommuniationis impossible[Cokburn, 2002a℄. Perfet ommuniation requires everything about asituation to be expliitly detailed. This is simply not pratial. Instead, the goal ofPlans-As-Communiation should be to manage the inompleteness of ommuniationwell � that is, to ommuniate just well enough for the intended audiene.3



Looking at these two modes of plan use, we have inadvertently disussed another keyelement of plans � their level of preision[Cokburn, 2002a℄. The extremely detailedexeution plan of the Plan-As-Program mode represents a very high-preision plan.Plans-As-Communiation in general an be lower preision, sine they assume someknowledge and some ability to improvise on the part of the user. Cokburn [2002a℄suggests that plans with di�erent levels of preision are useful at di�erent stagesin a projet, whereas the Systems-Gap-Working-Party [1984℄ suggests that di�erentlevels of detail are appropriate at di�erent levels in the organisation.During the ourse of our analysis of existing projet planning methodologies, it willbe useful to disuss eah in terms of the plan model (Program vs Communiation)and also the level of preision (low, medium or high). Both of these fators have ane�et on the level of detail typially present in the plan, whih we will also see whenexamining some projet planning artifats.2.2 Projet Planning in the Business World2.2.1 Traditional Projet PlanningPlanning as desribed in the traditional POMA (Planning, Organising, Monitoringand Adjusting) management yle [Tsui, 2004℄ is a very thorough a�air that results indetailed plans from the outset. The key thread running through all of POMA is thatthe projet must be ontrolled throughout its life yle. The fous during eah setionhighlights this: Planning de�nes every piee of work that must be done as well aswhen and by whom; Organising sets the team up to arry out the plan; Monitoringensures that deviations from the plan are identi�ed; and Adjusting reti�es thesevariations through relevant ation.POMA is desribed as just one methodology for projet management, but uponinspetion most other methodologies appear to be slightly varied artiulations ofthe same approah. Although only Tsui [2004℄ spei�ally identi�es POMA as theframework for the planning proess then desribed, the same key faets are evidentin standard management and software engineering texts, suh as Lok [2001℄, Som-merville [2001℄, Brown [1998℄ and Kliem and Ludin [1993℄. Other soures employ thesame approah but with emphasis on di�erent aspets � for instane, Goodpasture[2004℄ fouses on quantitative methods for estimation, monitoring, et, whilst Kliemand Ludin [1992℄ are most onerned with the �people fator� inherent in any projetwhere the atual results are ahieved by a team.Looking at the various texts available we an derive the following as the steps thatmake up the traditional projet planning proess :
• De�ning projet goals and objetives.
• Breaking down the work into its omponent tasks .
• De�ning the dependenies between tasks.
• Estimating the e�ort to omplete eah task.4



• Identifying the resoures available.
• Construting a shedule based on these e�ort & resoure estimates.
• Identifying any resoure lashes and �levelling� the plan to distribute the workevenly.In theory, the plans produed by this proess are exellent � they are highly detailed,learly indiate the preedene of tasks, the shedule (whih inludes the projeteddelivery date, of ourse) as well as whih resoures are assigned to whih tasksand who holds responsibility for deliverables. Aording to the Plan-As-Programparadigm, it should be possible for the projet team to follow the plan to the letterfrom beginning to end and to deliver the projet on time, to spei�ation and withinbudget. Why then do some reports laim only 9 - 16% of projets atually ahievethis feat? [The Standish Group, 2005℄Tsui [2004℄ appears to believe that the planning proess is just not being followedwell enough:�Projet planning inludes a time-onsuming and very important setof tasks that is, unfortunately, often rushed. It is muh wiser to spendthe appropriate time needed to develop a good plan initially than to haveto make multiple and ostly adjustments later�But he himself goes on to aknowledge:�Even with a well-oneived plan, it is unusual not to enounter someonditions that require unexpeted hanges during the projet. However,having a well thought out plan failitates making projet adjustmentseven at a muh later phase.� [Tsui, 2004℄This appears to be a reurring theme. Even the staunhest advoates of the tra-ditional planning approah admit that it is unheard of for plans to remain bothaurate and unhanged throughout the ourse of the projet. The primary reasonfor this is obvious: human beings annot see into the future. At the start of a projetit is very di�ult to fully understand even the projet itself, let alone predit hangesin resoures, requirements, the environment or any number of other fators. Brown[1998℄ summarises the issue:�Planning requires a large amount of information, and the amountand quality of information whih you will have is inversely proportionalto the length of time between when you plan and when the tasks shouldbe exeuted�So we an see that it is virtually impossible to reate a omplete, aurate Plan-As-Program at the beginning of the projet. This leads us to the realisation that theplans will have to be updated as irumstanes hange, opportunities or setbaks5



are disovered or original estimates prove to be inaurate. Despite Tsui's assuranethat a well thought out plan will make adjustments at a later stage easier, a numberof soures warn against projet managers spending all their time updating the shed-ule and not atually managing the projet (Blok and Frame [1998℄, Brown [1998℄,Anderson et al. [1988℄, DeMaro [1997℄)Surely though the only ertainty in a projet is that things will hange? If hanges(and the updates and adjustments they neessitate) make plans too time-onsumingto keep updated, should we not just give up on the idea of planning altogether?Lukily, this is not the only option. If we look more losely at the output of traditionalprojet planning, we realise that these plans are extremely high preision. So muhdetail is inluded that day-to-day tasks are planned months and years in advane.It is for this reason that updating the plans is so time-onsuming, as alluded to byLok [2001℄:�Although it is possible to shedule more than 100 jobs on an ad-justable bar hart, resheduling is a di�erent story. Setting a omplexplan up in the �rst plae might take a few working days or a week. Adjust-ing it subsequently to keep in step with hanges might prove impossible�In fat, the level of detail that is assumed to be needed, along with the time-onsuming nature of subsequent updates, auses many projet managers to avoidplanning ompletely:�The more preision in the plan, the more fragile it is, whih is whyonstruting Gantt harts is so feared: It is time-onsuming to produeand gets out of date with the slightest surprise event� [Cokburn, 2002a℄So it would appear that there are many problems with traditional projet plan-ning: the initial planning proess is very time-onsuming and although it produesseemingly useful, detailed plans, these soon beome out-of-date. Monitoring this,adjusting the plans or even re-planning ompletely (as is sometimes needed) is suha time-onsuming proess that it often beomes the projet manager's primary task,elipsing other ativities. Worse still, sometimes the plans are not updated at all,eventually resulting in �management by risis� [Kliem and Ludin, 1992℄, where theprojet reels from one issue to the next with very little strategi planning beingemployed.2.2.2 Alternatives to Traditional Projet PlanningObviously some remedy is needed to this dire-sounding situation. A number ofalternative strategies have been suggested to ombat the problems enountered intraditional projet planning. One is to keep the proess the same, but aknowledgethe time-onsuming nature of the updates proedure and bring in speial resoure todeal with projet administration issues. This is an approah known as �The ProjetO�e� [Blok and Frame, 1998℄, where a speialist organisation well versed in projet6



management tehniques and tools handles these aspets of projet management.Although this theory experiened some popularity in the nineties, in most industriesthe pressure to redue pereived resoure �waste� means that it is unlikely to be aviable solution for most organisations. Additionally, the inreased overhead to supplythe external organisation with the information required to plan may outweigh anysavings.A more fundamentally di�erent alternative is Goal-Direted Planning [Andersonet al., 1988℄, whih aims to fous the projet e�ort against the PSO (People, Sys-tems & Organisation) goals whih make the projet worthwhile. Rather than plan-ning tasks in detail at the outset, the approah reommends that only an outlineplan is produed initially. This skeleton plan should diretly relate to the goals ofthe projet. Subsequently, ativity plans are onstruted using a �rolling wave� ap-proah. This essentially means that detailed plans are only onstruted for a phasewhen it is soon to begin. This inreases the hanes that enough will be known toreate a useful detailed plan. Although the Goal-Direted approah at some stagesseems to employ more of a Plan-As-Communiation approah, the �nal produts arestill high-preision ativity plans, so the atual plans in use by those doing the workwill re�et the Plan-As-Program mentality.Milestone Planning[Anderson, 1996℄ is a method based on Goal-Direted Planningthat embraes the Plan-As-Communiation model more enthusiastially. It advisesagainst ativity planning (an inherently Plan-As-Program approah) sine this fo-uses the e�ort on time spent engaging in a task, rather than the results to beahieved. Anderson [1996℄ points out that it is not only di�ult to understand thewhole at the start of the projet, but also unwise to do so, sine the results of theearlier stages of the projet may lead to unforeseen opportunities or the need forextra e�ort if things have gone badly. Additionally, the path to the result is left�exible so the most appropriate route an be taken when the time omes.There are two approahes to sheduling for Milestone Planning. The �rst is to baseperformane on past projets and so set the milestone dates aordingly � this isa popular hoie if there is some �xed end-point to the projet, although shedulepressure and �Can Do� management [DeMaro, 1997, 2002℄ need to be avoided to keepthese realisti. The seond is to estimate by identifying the most time-onsumingtask to omplete a milestone and then adding ontingeny. Although neither of thesemethods is likely to result in a orret shedule, there is a de�nite advantage thatthis is more obvious in this ase. Whereas in traditional projet planning shedulesare often wildly inorret but look detailed and therefore believable, with milestoneplanning there is less tendeny to believe in unrealisti delivery dates.Milestone Planning produes low- to medium-preision plans whih are muh easierto modify. They also follow the Plan-As-Communiation model muh more on-sistently, fousing on the results to be ahieved and leaving the hoie of spei�ation up to the user of the plan. For these reasons it seems a muh more attrativeandidate for �exible, reative planning than the traditional projet managementapproah or the alternatives disussed above.Despite its apparent attrativeness, however, Milestone Planning has not been adoptedby projet managers. As we will disuss in the following setion, one reason for thismay be that the form that the plans take does not lend itself to use by projet teams.7



2.3 Plan RepresentationsThere are a variety of plans produed by various stages of the planning proessesalready desribed. Some show just the work to be done and how it an be brokendown (e.g. Work Breakdown Struture), others fous on what needs to be ahieved(e.g. Milestone Plan) or the dependenies between tasks (e.g. Network Diagram).However, the most popular type of plan urrently used ombines a alendar/timeelement with a task listing � the ubiquitous Gantt hart. In this setion we willexamine the various plan representations in a little more detail.2.3.1 Traditional Plans2.3.1.1 Work Breakdown StrutureA Work Breakdown Struture (WBS) is a hierarhial list of tasks that make upthe overall projet. In order to onstrut the WBS, the external deliverables areonsidered and the tasks needed to produe them are listed. Then eah task isfurther subdivided until it is of a �manageable� expeted duration (heuristis vary:anything from 1 day to 8 week units are suggested). The representation of the WorkBreakdown Struture is usually like a family-tree diagram, with hild tasks onnetedto their parent tasks, rolling up into the total projet.WBSs an be useful sine they enourage thought about what is atually involvedin ahieving a task, but they are usually used as a stepping stone towards a Gantthart, CPS or Network Diagram rather than plans in their own right, sine they arereally just diagrammati task lists.

Figure 2.1: Work Breakdown Struture Example � subsetion of a larger plan2.3.1.2 Network DiagramNetwork diagrams take many forms, but typially they show tasks, their expeteddurations and the dependenies between them. Variations exist that show �ativity8



on node� or �ativity on arrow� for instane, but in terms of information presentedthere is very little di�erene. In pratie, network diagrams are often more useful toillustrate dependenies between tasks as they are being drawn (or to highlight thee�et of a delay on the shedule) than as total representations of plans as they anbe quite onfusing to read.

Figure 2.2: Network Diagram Example � subsetion of a larger plan2.3.1.3 Gantt ChartGantt harts are a speialised form of bar hart that typially show the task list inrows on the left-hand side and some time line in olumns. Retangles are drawnto show task durations, as well as slak time and dependenies. Although networkdiagrams are often used to ompute dependenies and the shedule basis, Ganttharts are muh better visual aids and are better at ommuniating a plan to projetteams or stakeholders[Lok, 2001℄. Gantt harts also often have a resoure dimen-sion, either showing the person assigned to the task alongside the task name, oroasionally by olouring the task bloks appropriately.These are often the most popular plan representation, beause they are easy to readand give a �big piture� view of the projet. The level of preision is very high withthis type of plan, beause not only are detailed tasks shown, but also the spei�dates when they should be worked on and who should be working on them. It is nowonder that in many projets they are left unhanged as the projet progresses, asupdating all these dimensions would be a time-onsuming task.2.3.1.4 Extensions to Traditional PlansThere are some ommon extensions to traditional plans, the most ommon beingCritial Paths and Resoure Alloation information. Critial Paths are the longestpossible paths from the start of the projet to the onlusion [Kliem and Ludin,1993℄, if you ignore slak. They are usually identi�ed by doing a �forward pass�(alulating the length of the path using the earliest start and �nish dates, startingat projet ommenement) and then a �bakward pass� (alulating the length usingthe latest start and �nish dates, starting at the projet onlusion and workingbakwards). The paths for whih the total length is the same for eah pass are9



Figure 2.3: Gantt Chart Example � subsetion of a larger planidenti�ed. These paths then represent the olletion of tasks that have no slak � noroom to manoeuvre.Resoure Alloation information is used to trak how e�etively partiular projetresoures are being used (or if they are over-subsribed!). It is usually added toGantt harts or other shedules, showing whih team members are alloated to whihtasks. This information an then be used for resoure levelling, but in pratie thedegree of e�ort, estimate detail and auray needed to return the orret resultis a barrier to this pratie. Oasionally the software will try to level resouresautomatially, but this an be disastrous in knowledge work where resoures aresimply not interhangeable[Spolsky, 2005℄.A variation on the resoure angle is responsibility information. Sometimes plans willjust show the resoure assigned to lead the work on the task, indiating that theyare responsible for delivering it. Oasionally more detail is provided, for instaneto show the RASCI1 roles[Quik, 2005℄. Responsibility harts an be useful if theyare atively used by the projet team, but often the responsibilities depited are notpereived as the �real� responsibilities and so their usefulness is redued. To be ane�etive tool, the team proesses have to support their use and transpareny.2.3.2 Alternative Representations2.3.2.1 Milestone PlanA Milestone Plan an have a variety of forms. Those desribed by Anderson [1996℄resemble network diagrams, in that the milestones are represented as graph nodesand dependenies denoted by lines and arrows. The low-preision projet mapsdesribed by Cokburn [2002a℄ appear to be a variation of milestone plans as well.1RASCI is a tool used to de�ne involvement in deisions in projet management. It is anaronym, standing for Responsible, Aountable, Support, Consult, Inform, de�ning the roles thatvarious individuals have in a deision or deliverable.This is best illustrated with an example: Jak may be responsible for delivering a piee of fun-tionality, but his boss Mary is aountable. Coworkers Jim & Niola will provide support, helpingJak write the funtionality, whereas Rob has experiene in the area and so is down as someone toonsult. Ellen is working on an assoiated area and so needs to be informed of the implementationdeisions taken. 10



In ommon with Milestone Planning, the key advantage of this type of plan is that itfouses on the results that need to be delivered. Sine the plans are low- to medium-preision, they are less fragile than some of the higher preision plan representations(suh as network diagrams and Gantt harts). They also do a good job of giving anoverall piture of the projet without prematurely ommitting to arbitrary deadlines� a major risk in shedule-pressured projets [DeMaro, 2002, Anderson et al., 1988℄� and allow more ollaborative thinking about the projet plan as a result.This type of plan is one of the only found that is designed to be a Plan-As-Communiation.Although the results that need to be delivered are very learly depited, the methodof ahieving this is not spei�ed. The authors of the approah do reommend, how-ever, that detailed task planning is arried out, so the Milestone Plans are supple-mented with traditional Work Breakdown Strutures and Gantt Charts.2.4 Planning in Arti�ial IntelligenePlanning has long been a key hallenge in the �eld of Arti�ial Intelligene (AI). Theability to plan is seen as a prerequisite for autonomous and intelligent behaviour. Wewill �rst disuss lassial planning and some traditional methods and then some ofthe more modern approahes that fous on operating in a dynami world.2.4.1 Classial PlanningMuh of the traditional AI planning researh foused on lassial planning, wherethe environment is assumed to be �fully observable, deterministi, �nite, stati anddisrete� [Russell and Norvig, 2003℄. This means that the agent an get omplete,aurate, up-to-date information about its environment (observable), be sure whatthe outome of an ation will be (deterministi), omprehend the total environment(�nite), assume that only its own ations will a�et the state of the environment(stati) and that there are only a �xed number of states, ations and so on (disrete).This information about the state of the environment, ations available, et, is rep-resented symbolially, so that the agent an reason towards the required goal. Im-mediately two issues with this approah beome apparent, whih Wooldridge [2004℄desribes as the transdution problem (translating the real world into a symbolirepresentation in a timely manner) and the representation/reasoning problem (ap-propriate symboli representation of information and adequate reasoning using thisrepresentation). Essentially, it is di�ult to turn the outside world into an inter-nal model and then to plan with it quikly enough to be useful. Although varioustehniques are used to mitigate these issues, they are fundamental hallenges withplanning for AI systems generally.We will now disuss some examples of planning algorithms used in traditional AIplanning. The simplest way of thinking of a plan is as a series of ations whih willtake the environment from the initial stage through to the desired goal stage. Whenall the possible ations and environmental states are known, it is of ourse possibleto think of this problem as a searhing hallenge � one need only try every possible11



ombination of ations until one that results in the goal is disovered. This is knowas brute-fore searhing.Two planning algorithms that regard planning as searh are progression and regres-sion planning [Weld, 1994℄. Progression planning is also known as forward-hainingstate-spae searh, beause it starts with the initial state of the world and then workstowards the �nal goal. Regression planning is sometimes alled bakward-hainingstate-spae searh beause it does the opposite, starting with the desired goal andworking bakwards to �nd a sequene of ations that starts in the initial environmen-tal state. It is easy to imagine that even with a limited number of ations and states,the number of possible ombinations (and therefore plans) is immense. Searhingthrough all the possible ombinations an be highly ine�ient. More reent researh(starting with MDermott [1996℄) indiates that the use of appropriate heuristis toguide the searh an help mitigate this problem, however.The latter approahes are also sometimes referred to as Total Order Planning, be-ause the resulting plan is a list of ations that have to be exeuted in exatly theorder provided. A more �exible alternative is Partial Order Planning, where therelevant ations that need to be taken are spei�ed in the resulting plan, but orderof exeution is only spei�ed when neessary. The resulting plan is more a graph ofsub-plans than a �xed list, whih allows the planner to take advantage of problemdeomposition. This type of planning is also sometimes alled �least ommitmentplanning� [Weld, 1994℄, beause it allows deisions to be delayed unless there is aompelling reason to deide immediately: for instane, when dressing in the morning,it is possible to delay hoosing whih tie to wear until after one has put on a shirt;equally, the deision ould be taken the night before if desired.There are of ourse other lassial planning approahes, the most notable omissionbeing a disussion of logi-based planning methods. However suitable logi-based andother similarly mathematial methods may be for omputers, they are very unlikelyto be useful for planning arried out by business people, who prefer less formalmethods. For this reason they have not been inluded in the disussion here, but forfurther reading of the area, Wooldridge [2004℄ has a good overview and pointers tokey soures, as do Russell and Norvig [2003℄.2.4.2 Planning for the �Real World�Whihever planning method is atually hosen, lassial planning methods all havesomething in ommon � the plan is produed and then followed exatly, with littleregard for hanging onditions that might require di�erent ation from that whihwas planned. In theory this is �ne, sine the approahes desribed above require theenvironment to be bounded and preditable in various ways. However, when tryingto reate agents to at in real-time, in the real world, this kind of simpli�ation is areal barrier to e�ay.In order to deal with the dynami, non-deterministi nature of reality, we mustbuild robustness into our planning methods. We have to deide what to do whensomething goes wrong (e.g. replan or swap in an alternative plan) and also opewith sheduling. One way to do the latter is to separate planning from sheduling12



� identifying �rst what should be done and then when partiular steps should beexeuted. A ommon framework for doing this is Hierarhial Task Network (HTN)Planning, followed by Critial Path Sheduling. Both these approahes may soundvery familiar, sine they are very similar to projet planning tehniques, namelyWork Breakdown Struturing and Critial Path Sheduling.Hierarhial Task Network (HTN) Planning's key priniple is to break down theproblem into several parts, eventually reating a hierarhy of tasks via ation deom-position. Ation deomposition is the proess of replaing high-level ations with apartially ordered set of lower-level ations [Russell and Norvig, 2003℄. The initialplan is thus a high level desription of the problem to be addressed, whih is sues-sively re�ned until only primitive ations are left. The key question in this method ishow the replaements are found � usually a plan library ontains ready-made ationdeompositions from whih to hoose.This raises another issue: how are the plan libraries onstruted? Ideally when theagent needs to solve a problem �from srath�, then the resulting plan is stored insuh a way that it an be found and reapplied to similar problems. The reality isquite often, however, that human intervention is needed to populate plan librariesfor use. As Bryson and Stein [2001℄ note,�human designers do most of the hard workin arti�ial intelligene.�Critial Path Sheduling an be applied one a partially ordered plan has been pro-dued � various routes forward and bakward through the plan are disovered. Theritial path is the longest route through the steps in either diretion � a path thatonsists entirely of tasks that annot slip (i.e. have no slak). The sheduler thenprioritises those tasks that are on the ritial path, both in terms of time and re-soures. The intention is thus that the overall plan will omplete in the shortest timepossible.Although HTN Planning does give us the framework to reat to hanges in the envi-ronment, the preise mehanism for reating to non-determinism in the environmentis open to disussion. Next we onsider some ommon options:
• Sensorless Planning � systems that use sensorless planning do not identifyhanges in the environment, but rather onstrut a plan that will ahieve thegoal from any initial environment state. This type of planning is also sometimesreferred to as Universal Planning [Shoppers, 1987℄ and relies on the ability tooere the environment into the desired state. Although in simple ases thisan work, in situations where irumstanes may well be very unpreditable,its suess is unlikely.
• Conditional/Contingeny Planning � plans are onstruted with various branhesto over di�erent eventualities. During exeution, hanges in the environmentare sensed and the appropriate plan branh �swapped in� to amend behaviouraordingly. The obvious �aw with this method is that unexpeted irum-stanes will have no orresponding plan branh and so the agent will eitherstop or possibly ontinue exeuting a potentially ine�etive plan. It is also of-ten di�ult to identify when a ontingeny should be sought and also to maththe required plan branh to the situation.13



• Exeution Monitoring and Replanning � as the plan is being exeuted, theenvironment is onstantly monitored. The system responds to hange by re-planning. The danger is that in a frequently hanging environment, the systemmay keep replanning and fail to at. Valid heuristis to deide when to at,when to replan and when a plan is �good enough� are needed for this to be ane�etive planning method. This need has led to the development of AnytimeAlgorithms [Zilberstein, 1996℄ whih always return a useful/orret plan, butprodue greater quality plans the more time allowed for proessing.Another shool of thought fouses on reative and hybrid approahes. One of theommonalities of these various approahes is the belief that �intelligent behaviouremerges from the interation of various simpler behaviours� [Wooldridge, 2004, p.89℄.Grand [2001℄ took this onept to the extreme with his work in the area of arti�iallife, produing seemingly intelligent reatures by modelling physial entities (inlud-ing brain synapses and hormones) to build up a omplex being. The more familiarmodel used in reative agents, however, is the subsumption arhiteture proposed byBrooks [1986℄. This multi-tiered arhiteture o�ers a number of simple behaviours,organised in a hierarhy � these are mathed to the pereption of the environmentand alled appropriately.Surprisingly omplex emergent behaviour is possible using this type of approah.This was originally demonstrated by Agre and Chapman [1987℄ with their PENGIsystem. Their agent played a omputer game alled PENGU and exhibited whatseemed to be rational, planned behaviour when in fat it was merely enoded withsome simple opportunisti behaviours. This type of approah seems the antithesisto the planning already disussed, but in fat there is a great deal of study devotedto �reative planning�.�Reative planning is something of an oxymoron. It desribes the wayreative systems handle the problem traditionally addressed by onven-tional planning: ation seletion. Ation seletion is the ongoing prob-lem (for an autonomous agent) of deiding what to do next� [Bryson andStein, 2001℄Reative planning di�ers from lassial planning in a key way. Whereas lassialplanning maps an entire series of ations, starting at the initial environmental stateand ending in ahievement of the goal, reative planning is only onerned with theimmediate next ation. Reative plans are therefore onstruts whih speify theation to be taken next, given the urrent state of a�airs. These are sometimes alsoknown as ondition-ation rules [Pryor and Collins, 1996℄. In the following setion wewill disuss how this and various other AI planning approahes might be reappliedto the projet planning domain.2.5 Disussion :: Parallels Between AI andProjet PlanningThere are a number of parallels between arti�ial intelligene planning and projetplanning. There are also some lear divergenes. Our aim in this setion is to14



disuss the similarities and di�erenes between AI and projet planning, identifyingboth avenues that have already been explored and possibilities yet to be tested.Most striking in the AI planning world is the plethora of approahes, both for taklinglassial planning problems and the issues of operating �in the real world�. In projetplanning, on the other hand, relatively few alternatives have been proposed, withmost writers in the �eld seeming to believe that the traditional projet planningproess is the ideal.Although a few bravely try to suggest that some aspets of the traditional projetmanagement proess are di�ult to follow for the busy projet team [Anderson et al.,1988, DeMaro, 1997℄, the majority hoose to believe that the proess is simplynot being followed well enough. Many more stringent methods are suggested, fromimproving estimation using sienti� methods [Goodpasture, 2004℄ through to havinga spei� group of people devoted to planning, separated from the projet [Blok andFrame, 1998℄.The piture in AI planning researh is very di�erent. A number of methods havebeen tried and proven not to be satisfatory, leading to the development of otherapproahes and their testing, in turn. Where the reasons for a method being �awedare transferable (i.e. still relevant when planning and exeution is being done byhumans rather than mahines), the lessons learned are potentially very interestingto reapply to projet planning.Let us �rst onsider lassial AI planning. The attitude to the environment and tothe plans themselves is very similar to the traditional projet management approah.External events that might in�uene the environment are no more onsidered intraditional projet management than in lassial AI planning. Both appear to believethat if the initial state, ations available and desired goal state are known, then aplan an be onstruted. That plan an then be followed exatly and at the end thegoal state will be reahed. Lok [2001℄, however, regards this blind following of aplan rather disparagingly:�There is an alternative management approah that relies only on outgo-ing instrutions, with no feedbak or error signals. This is alled �man-agement by surprise� beause the manager feeds in work at one end ofthe system and is surprised when it doesn't ome out the other!� [p.226℄One de�nite di�erene between lassial AI approahes (suh as progression & re-gression planning) and traditional projet planning is the approah to task seletion.Whereas the aforementioned omputerised methods onsider all possible task ombi-nations and then searh for those sequenes that begin in the right state and end inthe goal state, human beings employ �ltering in seleting tasks. This is both logial(knowing, for instane, that shoes should not be put on before soks) and sometimesbased on previous experiene (e.g. knowing that writing a long doument will takeat least three times as long as originally estimated).Humans have an intrinsi ability to onsider only the most relevant potential ations.They are also adept at learning from experiene and applying this knowledge tosituations identi�ed as similar. An example of this type of �ltering is disussed by15



Caul�eld and Bryson, when investigating how humans hoose their next move whenplaying hess. People are also good at identifying ases where the order of ationdoes not matter, so although Partial Order Planning was a great breakthrough forAI planning, it would not be a new onept to projet planning. Although someplan representations fail to show the non-sequential nature of some tasks, the mostpopular � the Gantt hart � is perfetly suited to do so.When we onsider AI planning methods that have been developed for operation �inthe real world�, however, more parallels and opportunities beome apparent. Hi-erarhial Task Networks evidently lean heavily on the Work Breakdown Strutureplan format that is an integral part of traditional projet planning. Sensorless Plan-ning is sadly similar to the �management by surprise� situation desribed above byLok [2001℄, but Conditional/Contingeny Planning seems an interesting avenue toexplore.Traditional projet management does not identify ontingeny planning as a neededstep, however sensible it may seem to onsider situations that might arise and on-strut alternative plans. The only method that advoates suh an approah is in fata software engineering methodology � Boehm's Spiral Model [Boehm, 1988℄. Thismethodology is foused around risk management when building software : after eahiteration of gathering requirements, designing, implementing and testing, there is anexpliit risk analysis stage.Some other projet management texts, suh as Kliem and Ludin [1993℄, suggest thatrisk analysis is an important proess, helping reations to problems to be reasonedand onstrutive rather than the �rst solution to ome to mind, but most do notover risk management beyond the initial feasibility study. Even in those ases whererisk management is disussed, it is not regarded in the same way as AI's ontingenyplanning. Rather than providing new branhes of the plan to replae the existingplan, risk management strategies are usually just measures to overome the risk,with the projet thereafter ontinuing to follow the original plan.In fat, the approah that is presribed by those texts that do reognise that theenvironment or irumstanes may hange is most similar to the AI approah ofExeution Monitoring & Replanning. One might assume, therefore, that the issuesexperiened when using this approah in arti�ial intelligene are overome by ahuman planner, in the same way that the ation seletion problem is. Unfortunately,this is not the ase. Although most texts hold that replanning is needed wheneverirumstanes hange, they also bemoan the time that this takes:�The projet manager beomes suked into a spiral of planning and re-planning. He must assign new roles and responsibilities for new work,while old resoures are assigned to new tasks for whih they are unsuit-able. Eventually, the projet manager spends so muh time replanningthat he eases to manage� [Anderson et al., 1988, p.16℄One di�erene is in where the problem lies. At root, the issue is that too muh timeis spent replanning rather than ating � the result being that when the irumstanesare hanging frequently, the planner an end up failing to at ompletely, stuk in a16



replanning loop. What tends to take up most of the AI planner's time is hoosingthe orret ourse of ation � whereas in projet planning, human planners tend toupdate the tasks relatively easily and orretly, but problems our in another area:estimation.Estimation is not only a problem when replanning � it is learly a hallenge through-out the planning proess, with a great deal of researh dediated to improving estima-tion methods. Quantitative methods are suggested by Goodpasture [2004℄, weightedaverages by Kliem and Ludin [1993℄ and rules of thumb by Sommerville [2001℄. Inpratie, however, estimation appears to be the area most skimped upon [Williams℄.This is truly dangerous, sine a detailed plan with inorret estimates is often asign of �Can Do management� [DeMaro, 2002℄ � and indistinguishable to stakehold-ers from a real plan. This, ombined with inadequate traking and reporting, anlead to runaway projets that go over shedule and budget without the stakeholdersrealising.An approah that has little re�etion in projet planning methodology is ReativePlanning. This seems ounter-intuitive, sine it is the area most foused on reatingto hanges in the environment. In some ways, though, it makes sense, sine projetmanagement is spei�ally targeted against purely reative behaviour. A situationwhere the projet manager is simply reating to events in the short term is regardedas the undesirable inverse to a mediated, long term, planned ourse of ation. Thus,reativity is frowned upon, as exempli�ed by Kliem and Ludin [1992, p.77℄:�Projet managers must follow their plans. Little sense exists in investingmuh time and money in building plans and then never taking time toensure that everyone (inluding themselves) follows them. Yet not onlydo few projet managers plan, but they very rarely follow the plans theyhave developed. They may build an elaborate plan perhaps to prove totheir management and themselves that they know what they are doing.Then they quikly deviate from it. The result is projet managers witha reative style of management. The projet is replete with examples ofmanagement by onfusion, management by drives, and management byrisis. Projet managers soon ask themselves: What went wrong?�As we have already disussed, however, the advoated �exeution monitoring & re-planning� approah is deeply �awed, beause too muh time is spent adjusting theplans rather than atually modifying the ations. So perhaps there are lessons to belearned from Reative Planning? The �rst to ome to mind is the shorter term fous.As previously stated, the key task of a reative planner is seleting the immediatenext ation, taking into aount the long term plan, the environment and state andthe ations available.The only similarity that ould be found in projet management is the �rolling wave�approah advoated by Anderson et al. [1988℄, where detailed planning is only at-tempted when the relevant setion of the projet is about to be undertaken. Thisdoes not prelude longer term, less detailed planning (whih is indeed also the asein Reative Planning), but allows the fous on spei� ations to be taken only whenappropriate. This has the added bene�t that the overall plan does not have arbitrary17



detail in areas that are far into the future and therefore less likely to be orretlyplanned.We also again have an analogy to risk management � the ondition-ation pairs thatare a key struture in reative plans are similar to risk plans, where a potentialrisk is desribed and the ations to be taken to mitigate it if it ours. In fat riskmanagement is often dealt with by managers in a very reative manner � when arisk senario plays out, the risk plan is seldom fed into the overall projet plan, butinstead followed outside of the normal ourse of operation to deal with the risk.Arguably diret reappliation of reative planning would be di�ult, sine a greatdeal of skill is required to translate reative behaviour (i.e. hoosing the immediatenext ation) into goal attainment (i.e. ahieving the end-state atually desired).However, this does seem the most interesting area to explore in order to develop amethod for dynami and �exible projet planning. The eventual fous on the goals tobe attained and the behaviour that emerges from the simple seletion of next-ationsould prove to be highly useful in fousing projet teams on projet results ratherthan day to day tasks.Having onsidered traditional projet planning and the existing alternatives, we havefound that there is no suessful methodology designed for �exible projet planning.We therefore turned to the area of Arti�ial Intelligene planning, onsidering tra-ditional approahes, �nding that these were similarly �awed. In examining morereent advanes in AI planning, however, we have found some interesting onepts,partiularly in the area of Reative Planning. In order to apply these to projetplanning, however, we must �rst delve deeper into the way that projet plans areatually used, whih is the fous of the next hapter.
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Chapter 3Dynami Planning � A NewApproah
3.1 How Are Plans Really Used?The various projet planning approahes already onsidered make assumptions abouthow plans should be used. Some of those that disuss the issues with traditionalprojet planning onsider the reality of where this proess falls down, but almost allassume that the root issue is lak of adherene to the advoated proess, rather thanthe proess itself.In AI planning, however, beause the planning methods are being followed by agentsrather than people, it is easier to measure where the proess itself may be the prob-lem. One programmed with a ertain approah, absolute adherene an be expetedfrom agents and indeed it is possible to �step through� the planning proess and seethe plan being onstruted and followed1.As indiated when disussing the various AI planning approahes, issues and limita-tions have been investigated and identi�ed. Why then is this not the ase in projetplanning? In fat some soures (for instane Chatzoglou and Maaulay [1996℄) haveexamined the limitations of various methodologies. DeMaro [1997℄ also disussesthe typial failings of the projet planning approahes. Most of the researh in thearea fouses on problems with the planning proess. Little or no researh appears todisuss how the plans produed by the existing approahes are atually followed.Although the simple at of onstruting a plan an be very useful to gain a fullerunderstanding of the projet, an idea of whih areas will be espeially hallenging andwhere potential resoures onstraints will ome to light, most projet managementtexts intend the plans to be followed. As we heard from Kliem and Ludin [1992℄earlier, projet managers must follow their plans and ensure that the team does aswell.1 Testing in this way (where the inner workings are examined) is known in software engineeringas White Box Testing [Sommerville, 2001℄. 19



3.1.1 The Diret ResearhIn order to investigate whether this atually happened in pratie, a number ofplan users were surveyed. On the one hand, a group of Information Tehnologymanagers from a large multinational orporation were approahed � let us refer tothis as Group A. Due to the nature of the orporation and its training strategy, theseindividuals were all likely to have taken very similar projet management training.They were also at di�erent stages in their development as projet managers, fromrelative novies in harge of smaller sale projets through to large regional or globalprojets. The expetation was, therefore, that they would use similar plans andplanning tehniques, but apply them to projets of various levels of omplexity andin various stages of maturity.The seond group (Group B) was a more random sample, onsisting of individualswho responded to a all for respondents by the author, either in person or on theInternet. This group inluded students, tehnial managers at various �rms andleturers. The expetation was that this group would be involved in diverse typesof projets, although all would be related to tehnology in some way (due to thereruitment method). Equally it ould be expeted that the individuals in thisgroup would not all follow the same method for projet planning or use the sametype of representations.All respondents were asked to desribe the planning proess they typially used, aswell as the plans produed, inluding samples where possible. Follow-up interviewswere held to pursue partiular points and to larify assumptions. Although thesample size was relatively small (a total of 12 respondents, split equally between thegroups), the open-ended nature of the questions meant that a great deal of interestingqualitative data was gathered.3.1.2 Key ResultsThere were three general plan types that ourred again and again in the desriptionsand samples of the respondents. The most popular (whih 92% of respondents had)was a Gantt hart style plan. This was typially used for broad projet team andstakeholder ommuniation, often with the same plan being used for both groups.Most of the plans onsisted primarily of tasks, showing duration, start date and enddate for eah.However, on a number of plans milestones were also identi�ed and almost all ofthe plans that were intended for group use also exhibited some form of resourealloation. This varied from the very simple (initials on the task bars) through tothe omprehensive & omplex (olumns orresponding to the RASCI role assignmentmodel previously mentioned).The most interesting thing about the Gantt harts was not the ontent, but theusers' attitudes and omments about their use:�But to be honest, this is written at the start and then it just merges intomy todo list in xls [Mirosoft Exel spreadsheet tool℄ � � Respondent A520



�The Gantt hart is out of date!� � Respondent B2�[The Gantt harts are℄ referred to and updated in fortnightly meetingsduring the projets� � Respondent A2�... you need disipline to keep going bak to the original plan� � Re-spondent A4The impression here is that at best the plans are updated every two weeks and insome ases they are not updated at all! The fat that they are often not referredto exept on an infrequent basis strongly suggests that they are not used to deidethe day-to-day ations of the team members. Respondent A5 alls this out in the�rst quote above and the talk of todo lists and ation plans by a number of otherrespondents supports this assumption.It is not surprising, therefore, that the next plan type was the personal todo list oration plan. The former is the ubiquitous list of tasks that an individual plans toundertake; the latter is similar in struture but usually deided upon during a teammeeting. Oasionally ation plans are for the entire team (with responsibilitiesindiated) and so are projet rather than individual ation plans. The struture ofthis type of plan again ranged from the extremely simple (the simple list of tasks)through to annotated versions of the todo list, for instane showing deadlines ornotes and �nally to more omplex forms (suh as the time management grid shownin Table 3.1).The third type of plan, whih arguably ombines the two already mentioned, wasthe augmented alendar. This type of plan essentially onsists of a standard al-endar, marked with deadlines, milestones and tasks. An example an be seen inFigure 3.1 on the following page. The key advantage of this type of plan is that itmakes it easier to handle multiple projets and priorities � the user an set time asideto work on eah. Although these were only expliitly alled out by the members ofGroup B, further investigation found that those in Group A all use a entralisedorporate alendar system to book and keep trak of meetings, events and appoint-ments. They indiated that beause this is standard proedure aross the orporationthese type of plans are so integral to their daily work that they did not even thinkto mention them.Important and UrgentTasksE.g. Finish write-up Important but Not Ur-gent TasksE.g. Revise for examsUrgent but Not Impor-tant TasksE.g. Go to sale Not Important and NotUrgent TasksE.g. File bills awayTable 3.1: Time Management Grid21



Figure 3.1: Augmented Calendar Example2The key learnings from this investigation an be summarised as follows:
• Most respondents (92%) use a Gantt hart style of plan, but this is often notkept up to date.
• All respondents reported using an additional individual plan, either in theform of a todo list or the hybrid approah of the augmented alendar. Somerespondents use both of these in additional to projet plans.
• Almost all (11 out of 12) used olour in their plans to add extra information.
• Half reported that their plans inluded resoure alloation (primarily humanresoures & responsibilities).3.2 What Does This Mean For The Existing PlanningMethodologies?The most interesting �nding is that individuals all have personal plans in additionto projet plans. This, ombined with the omments about the out-of-date nature ofmost of the projet plans, indiates that respondents do not use the projet plans todeide their everyday ations. Even when they are in ontrol of the overall projetplans, users report that they still have personal todo lists and often do not keep theprojet plans up-to-date.What does this mean for existing projet planning methodologies? If the plans arenot being used to deide day-to-day ations of the projet team members, then itmeans that any time spent inserting detail of what ations are to be taken and whenis arguably time wasted. Nevertheless, the plans are still used in other ways, so the22



hallenge is to identify the bare minimum planning that ould be done and keep theplans useful.Another lear message from the Literature Survey and the diret researh is thatthe Gantt hart is a very popular plan representation. Despite the emphasis inboth projet management and software engineering on network diagrams, none ofthe respondents (who all work in Information Tehnology roles) identi�ed networkdiagrams as a form of plan that they used. In fat, a few respondents identi�ed thedependeny visualisation of Gantt harts as relatively useless, iting the umbersomenature of this funtionality in most planning software pakages as an irritation.3.3 The Need For A New ApproahSo far planning in general may have seemed somewhat disappointing � there appearto be ountless problems with the methods used to onstrut plans, their represen-tation and the way in whih they are followed. Nevertheless, planning is essentialto ensure that projets ahieve their objetives, agents meet their requirements andthat both people and agents take the best ation to ahieve the desired goal.What has beome lear, however, is that there is a de�nite de�ieny in the existingprojet planning methodologies. We have already seen that some great advaneshave been made in the �eld of arti�ial intelligene planning, though, so perhapssome of this knowledge ould be reapplied to the projet planning domain.This is in fat the approah that we will take in the following subsetion, but �rstlet us reap the key problems with existing projet planning methodologies and theplans they produe:
• Planning is a time-onsuming proess, whih is often negleted .
• Estimation is a key hallenge and, when done badly, results in inorret plansthat may nevertheless seem redible.
• A great deal of time and energy is put into planning, but then the projet plansare not used as intended.
• Projet plans usually onsist of tasks whih the projet team are intended tofollow, but in reality most individuals prefer to follow their own todo lists oration plans.
• Projet plans are frequently out-of-date, supporting the tendeny to plan sep-arately at an individual level.
• Although there are multiple plan formats available, only a few appear to beused.It is obvious that there are a number of problems in three key areas: the way thatthe plans are onstruted, their format and the way in whih they are used. In orderto onstrut a projet planning methodology that provides su�ient �exibility tomeet the demands of modern projets, all these areas will need to be addressed.23



3.4 Proposal: Dynami Projet PlanningIn de�ning a new projet planning methodology that deals with the aforementionedproblems, we will take a somewhat unonventional route, working bakwards andstarting with the issues in how plans are used, then disussing the format and �nallythe method of onstrution. This is so the entire methodology is onstruted withthe end in mind � providing �exible plans that are an asset to the projet team andhelp projet managers reat to hanging irumstanes.3.4.1 How Will The Plans Be Used?To go bak to Agre and Chapman [1989℄ and their seminal paper �What Are PlansFor?�, one key distintion that an be drawn between plans is their purpose. On theone hand there is the Plan-As-Program, where the plan provides the exat ationsto be taken, the order in whih to do so and often a shedule as well to show whentasks should be ompleted. As we have seen, most AI planning methods provideexatly this type of plan. This is in one way not partiularly surprising, sine it iswell aepted that omputers need expliit instrutions to perform tasks3.What is surprising, however, is that most of the projet planning methods produePlans-As-Programs too. Humans are the key example given of autonomous ation,of almost subonsious planning to ahieve a wide variety of tasks. People have theamazing ability to adapt to totally new onditions, one reason that the human raehas spread to every ontinent and survives in limates of every extreme. We, as arae, also have the enviable ability to learn from one experiene and reapply theknowledge to an alternative situation, both identifying the similarity and adaptingthe original situation to the new irumstane.All these things ombine to make it seem strange that plans for use by humans arePlan-As-Program, rather than Plan-As-Communiation, where the plan is used toommuniate the goals to be ahieved in a far less spei� way. Nevertheless, thisseems to be the standard. What we have already seen when asking people how theyuse projet plans though is that the presription of ativities is ignored. People seemto reognise in themselves the ability to deide exatly what to do for themselvesand to do so regardless of the level of detail supplied in the plan.One explanation of why this is so omes from the area of management study referredto as Organisational Behaviour, whih fouses on internal dynamis in ompanies. Arevolutionary book by MGregor [1960℄ hallenged the ore assumptions of the si-enti� approah to management, begun by Frederi Taylor in the 1890s. He referredto the existing approah as �Theory X� and to his alternative as �Theory Y�. Thekey attributes of eah approah an be seen in Table 3.2 on the next page, whihwas onstruted from information in Buhanan and Huzynski [2003℄.Despite the fat that most modern organisations subsribe to MGregor's �Theory Y�,rather than the more traditional approah that demands employees be told exatly3 Some new approahes, suh as the Arti�ial Work typi�ed by Grand [2001℄, take the alternativeapproah that software agents an be built up with the inherent ability to take deisions and performtasks, but the programmed method is still very muh the standard.24



what to do, the plans used in suh organisations do not re�et this shift at all. Despiteorporate poliy of distributing authority and responsibility, enouraging employeesto take pride in their work and to be reative, projet plans are still full of tasks,telling employees what to do and in what order to do so.Theory X Theory YAverage person inherently dislikes work Work is as natural as rest to peoplePeople must be direted to work People will exerise self-disipline andself-ontrolPeople wish to avoid responsibility People enjoy real responsibilityPeople feel ahievement at work isirrelevant Ahievement is highly valued by peopleMost people are dull and unreative Most people have imagination andreativityMoney is the only real reason for working Money is only one bene�t from workPeople lak the desire to improve theirquality of life People have needs to improve theirquality of lifeHaving an objetive is a form ofimprisonment Objetives are welomed as an aid toe�etivenessTable 3.2: Key Tenets of Theories X and YSo how should plans be used? Well, sine a number of those interviewed are verysuessful, one an assume that the way that they use plans is valid. We shouldexpet projet team members to supplement projet plans with their own personalplans, in the form of todo lists, or ation plans, or augmented alendars. The keyneed therefore is for the projet plan to ommuniate the objetives, priorities andimmediate goals of the projet.It is important, at this stage, to note that di�erent roles require di�erent things fromthe projet plan. The projet manager needs to use the projet plan to trak progress,so that adjustments and interventions an be made. They also need to be able toplan key resoures, at least in the short- to medium-term. Other stakeholders mayneed a high-level view of the projet progress to date and upoming work. Althoughthe Systems-Gap-Working-Party [1984℄ found that a key issue was �one size �ts all�plans and that di�ering plans, with di�ering levels of detail, should be onstrutedas appropriate for the various stakeholders, this either needs to be ahieved withouta great deal of extra e�ort, or the standard plan needs to meet at least the basineeds of all involved.Based on the indiations thus far, we will assume that task planning an be disardedand that the following are the key ways in whih plans will be used:
• Projet team members will use the plans� to identify urrent objetives, priorities and short-term goals� to soure their individual task/ation plans25



• Projet managers will use the plans� to map out the objetives, priorities and goals of the projet� to trak projet progress and identify adjustments/interventions to bemade� to alloate resoures and identify any resoure on�itsEssentially we are reapplying the priniples of the Reative Planning AI approah,but relying on the projet team members to make the appropriate ation seletionbased on the ontext and environment. This allows the projet manager to fousthe plan on the hanges to be ahieved with the projet (just as reative agentprogrammers fous on the emergent behaviour desired from the agents). It also allowsa more motivational working environment for the team members, sine this approahwill allow their reativity and autonomy to shine through and fuller responsibilityand authority to be distributed to eah team member.You will notie that we have exluded the way that other stakeholders will use theprojet plan. This is both to narrow the fous and based on the assumption that theprojet plan may not be the best ommuniative tool for stakeholders outside of theimmediate projet team. This is arguably an area that deserves further investigationat a later stage, however.3.4.2 What Will The Plans Look Like?Now that we have set out the key priniples and assumptions as to how the planswill be used, we an fous on what the plans themselves will look like. Althoughwe reviewed a number of di�erent plan representations during the Literature Survey,it beame apparent during the researh that very few of these are used in pratie.Although it ould be argued that this is beause most of the plan representations arenot fully understood, for our purposes here we will assume that the most prevalentplan type is popular beause of its utility and simpliity.The most popular is of ourse the Gantt hart. Its simpliity and graphial natureallow for �at a glane� understanding of the projet, or the work urrently beingundertaken, but it an also be augmented with a great rihness of detail. As wesaw during the diret researh, no single standard format is used aross the board.The key features of the Gantt hart are bars to show ativities, with their lengthindiating their duration (sine the x-axis shows a time sale). Colour-oding is usedin various di�erent ways as well, the only real standard being its presene � even plansonstruted by a blind user who partiipated in the study inluded olour-oding todenote projet phases!Based on the number of variations disovered even when surveying only a smallgroup, the key requirement thus appears to be �exibility in the presentation of theplans. Thus, the plans will be loosely based on Gantt harts, but the primary featureof the plans will be that they allow the users �exibility in how they hoose to denoteresponsibility, resoure alloation, progress and so on.26



The traditional Gantt hart does have a key disadvantage however � the basi unitis the task. Sine we have already deided that plans whih lay out exatly whatneeds to be done and when are a) not used as intended and b) not designed to takeadvantage of human skills, a plan that onsists ompletely of tasks and the timeswhen they should to be performed is obviously not ideal.Other researhers have identi�ed that ativity planning is often not useful [Anderson,1996℄, but usually with a fous on the inability to orretly plan detailed ativitiesat the beginning of the projet. Anderson, Grude, Haug, and Turner [1988℄ earliersuggested Goal-Direted Planning that fouses on what the projet is aiming toahieve and a more reent paper by Anderson [1996℄ suggests Milestone Planninginstead. The key issue with both of these approahes is that they produe plansthat are muh more akin to the seldom-used network diagram than the ubiquitousGantt hart. Additionally, they propose this milestone-foused planning only atthe beginning of a projet, advoating detailed ativity planning in a �rolling wave�approah.We propose a muh more radial approah, ombining the Milestone Planning ap-proah with AI's Reative Planning. In our plans, there will be no tasks, onlymilestones. Task planning is left to individuals and left ompletely out of the overallprojet plans. We also inorporate the idea of miniature milestones proposed byMConnell [1996℄ (sometimes also known as �inh pebbles�). These allow milestonesto be divided into submilestones and these in turn to miniature milestones.Ideally a miniature milestone should signify a result ahievable within a week. Thisallows the projet manager to easily trak progress, in fat muh more easily thanwas possible with traditional task-based plans, sine a milestone is either ahievedor not. They are binary measures of progress, rather than relative measures � tasksan be 10% omplete or 90% omplete and the measurement relies ompletely uponestimation, a generally �awed ativity (as we have seen).There are a number of advantages to this approah. It fouses the team on whatis meant to be ahieved in the projet, rather than the ativities that they willengage in to ahieve the end result. This should lead to more aggressive pursuit ofresults, rather than �spending time� working on the alloated ativities at a partiulartime. Milestones are also less likely to hange than ativities. This means that theprojet plan will be more robust and the reativity to the hanging environmentleft in the hands of the person responsible for delivering the milestone, arguably thebest equipped to detet and respond to hanges in situation as they our. Theeasy progress monitoring will also help the projet manager identify when extrainvestigation or intervention is needed.The one remaining problem is the reoniliation with the representation of milestonesin a Gantt hart style. Milestones are typially represented as a irle with somesymbol that is linked to its desription. As mentioned, Milestone Plans are usuallymore like network diagrams than anything else. A key advantage of the Gantt hartis also that the bars give some indiation of duration, whih helps to identify anyresoure on�its.In order to solve this dilemma, we will represent milestones as bars, with the right-hand edge of the bar representing the time period in whih the milestone will be27



Figure 3.2: Dynami Plan Example (medium-preision)ompleted and the length of the bar giving some indiation of the amount of e�ortexpeted. Another advantage of this approah is that it is onduive to planning atvarious levels of preision. In the initial planning stages, a milestone's due date maybe expressed in terms of a partiular quarter or even year. Later on it may be tieddown to a partiular month or week. An example of a medium-preision dynamiplan an be found in Figure 3.2.To summarise, the key features of our plans are as follows:
• The basi unit of the plan is the milestone, shown as a Gantt hart bar, with adue date and an e�ort estimation to show when resoure is likely to be neededagainst ahieving that milestone
• Milestones ontain submilestones and miniature milestones to aid progresstraking
• Colour-oding and milestone labelling (as text alongside the milestone desrip-tion) are both available to be used by the user as they wish (e.g. for resourealloation or traking delays)3.4.3 How Will The Plans Be Construted?In disussing the plan that is the output of the planning proess, we have of oursedisussed some aspets of how the plans are onstruted. Therefore here we willmerely summarise the proess.At the beginning of the projet, a low preision plan will be onstruted, to ommu-niate to the projet team the key aims and objetives of the projet. This will bedone by dividing the end result of the projet into a number of oarse milestones,identifying the key deliverables that will add up to the desired produt or hange.The medium preision plan needed later on will be onstruted by dividing eahmilestone into a series of submilestones, adding resoure alloations and any otherinformation that is needed. Higher preision plans will inorporate miniature mile-stones as well, but these should only be onstruted for the immediate next phase28



of the projet. This avoids planning detail far into the future, when it may not evenbeen needed or issues are not well understood.During the original bakground researh for this projet, various existing planningpakages were reviewed. The details of the review an be found in the appendies.The net outome, however, was that all existing software was very muh geared fortask-based Gantt harts � to the extent that it proved impossible to attempt toonstrut a milestone plan, or the dynami plans suggested here, using them. Forthis reason, it was neessary to develop software spei�ally designed to supportDynami Planning, in order to evaluate the methodology. In the next hapter wewill disuss this proess and the appliation produed.
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Chapter 4Development of The DynamiPlannerTo failitate the evaluation of the Dynami Planning approah, it was neessary tobuild software that would support planning in this way and produe the type ofplan spei�ed in the previous setion. Here we will doument the proess followedin developing this software, as well as disussion of key deisions that were taken.4.1 Approah to DevelopmentThe hallenge was to produe a useful piee of software in a relatively short spae oftime. For this reason, a software development proess that supports rapid, evolution-ary prototyping was needed. An iterative approah seemed prudent and it was alsodeided that having fully funtional software at the end of any given iteration wouldbe desirable, in ase any risk fators presented themselves and ut development short.For all these reasons an Extreme Programming approah was hosen, as desribed byBek [2004℄. The key advantages of Extreme Programming are its fous on simpliityand elegant design, working ode at every stage and a steady, preditable progressionfrom one release to the next. Some aspets of the proess ould not be followed, mostnotably the Pair Programming and Customer Always Available tenets : the formerwas not possible beause the assessment for this projet must be individual and thelatter di�ult beause there was no real ustomer for the projet.4.2 Tehnology SeletionThe need for rapid development was again a signi�ant fator when an appropriatetehnology needed to be seleted. So was the nature of the appliation � sine theintention was for it to help the user onstrut a projet plan, a graphial user interfae(GUI) was required and so the availability and quality of GUI toolkits also neededto be onsidered. 30



Another key deision was whether the appliation should be web- or desktop-based.Having reviewed a similar projet undertaken by a previous student in 2003/4 [Rihards,2004℄, where the implementation was web-based, the usability issues presented byhaving to reload the page every time information was stored or loaded seemed toadvise against the development of a web-based system1.Thus, the list of potential tehnologies was redued to those apable of desktop-based GUI appliation development. The key options in this area were traditionallanguages suh as C++ and Java and modern sripting languages suh as Pythonand Jython.Both C++ and Java were strong ontenders due to their objet-orientation sup-port and extensive GUI libraries. Although C++ has no native GUI libraries, thewxWidgets/wxWindows toolkit [wxWidgets Website℄ is a freely available resourethat provides all manner of �native-style� widgets for GUI development on variousplatforms. The Java Swing/AWT toolkits [Java Website℄ have their own distintivelook & feel, but sine Java itself is apable of running on any platform that supportsthe Java Virtual Mahine, this option is also platform-independent.As already mentioned, however, rapid development was the key aim and for thissripting languages learly exel. Their redued formality and high-level funtional-ity helps the developer to ode quikly. Sine less ode is typially produed by asripting language ompared to the more traditional languages already mentioned,some also suggest that debugging is easier [Pilgrim, 2004℄. Python provides a hoieof GUI toolkit, inluding Tkinter (the native toolkit whih is unfortunately some-what limited) and wxPython [wxPython Website℄ � a Python API to the wxWid-gets/wxWindows C++ GUI libraries already disussed above. Jython [Jython Web-site℄, in turn, provides all the �exibility of sripting language but with full aess toall Java's standard libraries � inluding, of ourse, the Swing/AWT toolkits.The hoie was thus between Python and Jython. Either hoie would require learn-ing a new language, but sine Jython essentially uses the Java Swing/AWT GUItoolkits whih I had previously used, only Python o�ered the prospet of a new pro-gramming language and a whole new GUI toolkit. Sine one of the objetives forthe projet was to gain new skills, this option seemed more hallenging and thereforemore desirable.4.3 Requirements Eliitation4.3.1 Proess FollowedSine the software was largely developed as a vehile for testing the Results-FousedPlanning methodology, muh of the requirements eliitation onsisted of inspetingthe methodology and identifying the proess steps that needed to be supported. This1 Although more reently the development of the AJAX (Asynhronous Javasript And XML)tehnologies [Garrett, 2005℄ has heralded a new era of fast and responsive web appliations, at thetime when the tehnology was hosen for this projet, the AJAX approah was relatively unheardof. 31



was supplemented by evaluating existing planning tools to identify whih featuresworked well, whih less so and whih were inompatible with the new proess.The key vehile used to identify requirements from the methodology desriptionwere �User Stories� [Bek and Fowler, 2004℄, the primary building blok of ExtremeProgramming. User stories are a way of desribing software features, based on thepopular �Use Case� requirements spei�ation method [Cokburn, 2002b℄. Whereasthe primary fous of standard use ases is to speify the exat behaviour of thesystem so that development team and ustomers an agree on what ought to beimplemented, the fous of user stories is to divide the funtionality into hunks thatan be delivered inrementally. The full user stories an be found in the RequirementsDoument in the appendies.The requirements eliitation and spei�ation proess was well-suited to this projet.Sine there was only one developer and no real ustomer for the system, the relativeinformality of some of the proesses did not ause any operational di�ulties. Hadthe software been intended for general release as user software, then to ompleteit in the same amount of time would have required a larger team, a learly de�nedustomer or user group and potentially a more rigorous struture to the requirementsgathering and doumentation, to ensure that all stakeholders were properly informed.Additionally, a more user-entri requirements eliitation proess (for instane oneof the various options disussed by Preee et al. [2002℄ ) would have been preferable.4.3.2 Key RequirementsSine only the basi funtionality was needed to arry out initial tests into the e�ayof the new methodology, this was the primary fous during the development phaseof this projet. Nevertheless, the requirements eliitation did extend further, tothe intermediate and advaned level requirements whih would make the ReativePlanner suitable for use as a standalone piee of user software for projet planning.These are doumented in the appendies as referene for further work.The key basi requirements that needed to be satis�ed for the purposes of this par-tiular projet were as follows:
• Allow onstrution of a plan ompletely from milestones
• Display the plan as a Gantt-style hart, showing milestones and estimations ofthe duration of the work to ahieve those milestones
• Allow the user to save the plan, as well as to reopen and edit itAlthough these may seem deeptively simple, the resulting appliation is surprisinglypowerful. The approah taken throughout was to allow the user as muh �exibilityas possible, to extend or adapt the plan as they wished. This resulted in a veryuseful appliation, despite the apparently sparse feature set.
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4.4 System Design4.4.1 High-Level DesignThe overall arhiteture of the system re�ets the Model-View-Controller (MVC)pattern [Krasner and Pope, 1988℄ for user interfae design. This pattern separatesout the appliation appearane (View), the appliation data (Model) and the userinteration with the data via the interfae (Controller), so that eah aspet an beworked on independently. Although this pattern is useful in terms of ode divisionand lean design, it has the added bene�t that representations, interations and dataare separable. This means, for instane, that the way the plan is displayed within theappliation is separated from the atual plan data, so exports to alternative formatsshould be easily implementable.The ode struture of the appliation mirrors the MVC pattern well. Correspondingto the View aspet, there is a spei�ation of the struture, omponents and �look andfeel� of the user interfae itself. The Controller onsists of a number of event listenersand event handler methods � when the user manipulates the interfae, then the eventlisteners detet the user ation and all the orresponding event handler method.This, in turn, updates the data (Model) as appropriate. Although the Model odeis ontained in a separate lass �le (planData.py), the View and Controller ode areboth ontained in one �le (PlannerGUI.py) due to the way in whih the wxPythonframework works.4.4.2 User Interfae DesignThe Graphial User Interfae (GUI) was �rst moked up in a series of paper proto-types. The starting point was a omposite of the various interfaes of the existingplanning software pakages that were reviewed. Then everything that was not ne-essarily relevant and required by Dynami Planning was ut away, inluding startdates, end dates, resoure alloations, ompletion perentages and so on. From thisstark basis, a number of skethed iterations led to a design that was su�ientlyadvaned to be implemented.Obviously during the ourse of development the interfae developed further as fun-tionality was added. Throughout, the user interfae design priniples artiulated bySommerville [2001, p.330℄ were used as a heklist to identify possible problems withthe interfae. Additionally, a number of �Quik & Dirty� interfae evaluations (asdesribed by Preee et al. [2002, p.341℄) were exeuted with experiened planners.Although these were perhaps not as e�etive as full user/ustomer involvement in thedesign proess might have been, it was su�ient for this projet, given the priorityto produe software to test the methodology rather than a full produt.4.4.3 Overview of the InterfaeAs an be seen from Figure 4.1 on page 35, the user interfae for the ReativePlanner onsists of two basi grid strutures with a sliding separator down the middle.33



The left-hand grid is used for data input � this is where milestone data is entered,inluding due dates and so on. The right-hand grid displays a Gantt-style hart,whih is updated as the user adds or edits the milestone information.It was important to allow the user to see the overall plan as they were addingmilestones or updating durations, whih is why the diret input approah was hosenfor the main sreen. This was a lesson learnt from a previous student's projet[Rihards, 2004℄, where the input had been implemented as a series of web forms,separate from the plan itself. Immediate response (i.e. the updating of the Gantthart as soon as the user entered more milestone data) is also important, beauseduring planning it is useful to be able to examine �what if?� senarios [Kliem andLudin, 1993℄. Other aspets of the user interfae all aim to be standard and thereforeonsistent.The data input itself is very simple, following repeated feedbak during the diretresearh stage that software pakages suh as MS Projet o�ered too many options.Many of those interviewed reported that the interfae often led them to settingexat deadlines or introduing arbitrary nonexistent dependenies in order to makethe plans display as desired. Additionally, beause the time dimension in MS Projet(and similar) plans is very re�ned from the outset � usually set to days � the plansappear very preise from the beginning. This an often lead to a false sense ofon�dene in the estimates inluded in the plan, whih later leads to exaerbatedproblems when these estimates turn out to be �awed.For exatly this reason, the Dynami Planner defaults to a oarse time dimension.Sine the intention is that the user will �rst onstrut a low preision plan, onsistingpurely of milestones, the default (as shown) is that months are displayed. Equally,for large projets, the time dimension might be quarters or years. As the projetprogresses (and so the planning), the plan will graduate to a medium- and eventuallyhigh-preision version, adding sub-milestones and miniature milestones. As previ-ously stated, miniature milestones should never represent less than a week's work,so the most re�ned timesale will orrespond to weeks.Nevertheless, it may still be neessary to mark a partiular day � for instane, thereis a lear deadline for this projet and it is important to note the atual day and time,rather than just the relevant week. Flexibility is thus desirable in the representationof the plan itself. For this reason, there is an unstrutured notes �eld, to be usedas the user sees �t. In our given example, this would therefore be used to add inthe details of when the dissertation should be handed in. Equally, the milestonedesription ould also inlude the due date.Colour oding of the milestone bars (whih has not been implemented, but shouldbe if the planner was to be developed into a proper user software pakage) is anotherfeature designed to allow the user �exibility. One way in whih it ould be usedwould be resoure alloation, ahieved by assigned a partiular olour to a person orresoure. Another would be traking of whih milestones were ompleted by theiroriginal due date, perhaps by olouring those that overran in red.
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Figure 4.1: Sreenshot of the Reative Planner (running on Linux)35



4.5 System ImplementationThe system was implemented in a series of iterations, eah iteration ontaining anumber of features mathing the user stories in the requirements doument. Anyframework required for a partiular funtionality was implemented along with therelevant feature, in aordane with the Extreme Programming priniple of buildingode only when it is atually needed [Wells, 2004, "No Funtionality is Added Early"℄.An example of this was the storage of the plan data � in the initial stages the plannersimply used the GUI grid lasses (wxGrid) to store data as well as handle the userinput. Only when a separate internal representation of the plan data was needed (i.e.when the plan needed to be saved) was the planData lass written to enapsulate allthe plan data. This in turn is extendable to ontain other details about milestones(e.g. olour that the milestone bars should be, hierarhy level) but this ode will notbe written until its assoiated funtionality is developed.There are two lasses that make up the Dynami Planner. The main lass is thePlannerGUI.py lass, that enapsulates the Controller and View aspets of the ar-hiteture. The appliation itself is an instane of this lass and the onstrutorontains all the neessary ode to reate and ombine the GUI widgets. A number ofevent handlers are then bound to the atual interfae, so that when a partiular menuoption is pressed or other event ours, the appropriate response is alled. Theseevent response funtions are also augmented by a number of �helper funtions� thatperform minor tasks to aid the event response.The seondary lass is planData.py whih ontains all of the ode to handle the inter-nal representation of the data. Python has surprisingly �exible native data storageand so this is primarily a wrapper for a list of ditionaries � eah ditionary repre-sents a milestone and the Python list struture is akin to the arrays found in otherlanguages2. The lass handles data aess, as well as storing to �le (by �pikling�the data struture) and then reonverting saved �les into the objet representationneeded.Another impressive aspet of Python as a programming language is how muh an bedone with relatively little ode. The planner software in total only onsists of about500 lines of ode, whih is remarkably little given the funtionality. Admittedly, someof this is beause the wxPython GUI libraries enapsulate a great deal of what is used.Nevertheless, the language itself was found to be very elegant and understandable� few ode level omments are neessary, although of ourse lasses and methodshave been doumented appropriately. In fat, Python has the pydo utility whihexamines ode for do omments and auto-onstruts doumentation. All the odefor this projet has been written in aordane with the Python doumentationguidelines and so pydo produes very nie doumentation for the lasses.2 In fat, the Python list struture is quite advaned, automatially inreasing the size to a-ommodate any number of items, et. It is therefore more realistially omparable to an ArrayListstruture from Java.
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4.6 TestingThe approah taken during this projet was heavily in�uened by the Test-DrivenDevelopment approah advoated by Bek [2003℄. Before any ode was written, testswere written to speify when the funtionality would work as intended. In the ase ofthe GUI, these were largely user-oriented tests, in the form of sripts that a humantester would follow. For the data lasses of the Dynami Planner, unit tests werewritten.Python does have a unit testing framework, in the shape of the unittest module(disussed by Pilgrim [2004, p.272-277℄). However, sine it was only appropriate toonstrut automated tests for the data management aspet of the planner, it wasnot neessary to use suh a fully-featured tool. Instead, a Python �trik� was used: inluded in the planData.py lass �le is a setion of ode that will only run if the�le is exeuted on its own (e.g. by running python planData.py) rather than when itis used by another lass (i.e. when it is imported for use by PlannerGUI.py). Thisode spei�es a number of unit tests for the data management ode and displaysresults at the end to standard output, unless direted elsewhere.The rest of the planner ode was tested interatively, using sripts that speify howthe funtionality should behave. By their very nature, these sripts over both unitand integration testing, sine for the interfae to behave in the manner expetedModel, View and Controller setions of the ode must be working orretly together.Examples of these sripts an be found in the appendies, along with an indiationof whether the tests passed at the time of ompletion. Sine best pratie is to writetests before implementation has even begun, a number of test sripts are inludedfor funtionality that has not yet been implemented.An obvious omission from this testing strategy is usability/interation testing. Al-though this was aeptable in the development of a piee of researh software, ifthe software was to be released to a group of users as a projet planner then thisfailing would need to be remedied. The �rst step would be an expert evaluation toidentify potential pitfalls in the interfae as it stands. It might also be useful toexamine the ognitive model that users form when using the software and ompareit to that evidently desired by the methodology spei�ation, to ensure a math.Ongoing development should inlude user involvement in the testing proess, as wellas an appropriate route for feedbak on the design itself.
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Chapter 5EvaluationThe stated aim of the projet was to not only develop a new planning methodology,suitable for �exible planning in our unertain world, but also to onstrut softwareto be used to evaluate the new methodology. Thus, a disussion of the evaluationarried out and its results is an essential omponent of this dissertation. In thishapter we will disuss the evaluation of the Dynami Planning methodology andseparately that of the Dynami Planner, as well as the tehnology used and proessfollowed in developing it.5.1 Evaluating the Dynami Planning MethodologyThe �rst stage of evaluation for the methodology onsisted of a series of interviews.These were arried out with some of those who had partiipated in the diret researh,as well as number of other professional projet managers. First the bakground tothe projet was disussed, then the Dynami Planning methodology was presentedand �nally a number of questions were asked about how useful and viable a tehniquemight be in pratie.All felt that the methodology seemed to have merit and might be partiularly use-ful for software projets. Some were very exited about the onept and eager tosee whether the evaluation using the planning software would bear fruit. Othersexpressed onern that the milestone-based plans would not be able to ompletelyreplae the traditional task-based Gantt harts. This led to inreased fous in themethodology desription on the role of personal todo lists, ation plans and aug-mented alendars.The seond stage of the methodology evaluation was to test how easy the method-ology is to follow, as well as whether the plans produed are in fat more �exiblethan traditional alternatives. It was for this purpose that the Dynami Planner wasdeveloped, so that test subjets ould be asked to plan using software spei�allygeared to support the new methodology.A number of subjets were reruited to partiipate in this seond stage of the eval-uation proess. They had varying levels of experiene managing projets, with theonly prerequisite being that they understood the onepts of projet planning and38



had previously onstruted plans for projets. One ritiism that ould be made ofthe group that did partiipate in this stage would be that very few had signi�antprojet management experiene. Reommendations related to this fat appear in theFurther Work setion. On the other hand, there was an advantage in using subjetswith less experiene, as they proved less �set in their ways� and reeptive to the newplanning onepts presented.Test subjets were given an informal general desription of a projet to be undertakenover a seven month period and told that they ould assume that su�ient resoureswould be available to omplete the projet in this time. They were then asked toonstrut a plan for the projet, in the traditional style that they would normallyuse. This was done using MS Projet and then they answered a short questionnaireabout this initial plan. They were then asked to read a one-page desription of theDynami Planning Methodology and to then onstrut another plan for the sameprojet, using the Dynami Planner. After this they were again asked to �ll out ashort questionnaire, similar to the �rst.The �nal stage of the test involved the subjet being informed that a very signi�anthange had ourred that would a�et the projet. They were then asked to adjusttheir plans appropriately, after whih they again answered a number of questions.After the experiment had been ompleted, they were brie�y interviewed and theirthoughts on the methodology, software and the test itself were aptured.The results were very enouraging. All subjets found replanning signi�antly easierwhen using the Dynami Planning method and software. They also all felt that thedynami plans were thus more likely to be updated and so more useful for managingthe projet. Although the traditional Gantt harts are seen as easy to follow, allsubjets indiated they felt that the dynami plans would be even more so. A moredetailed summary an be found in the appendies.One mixed result was the ease of use of the Dynami Planning methodology itself.Although some of the subjets found the new proess natural and aessible, othersfound it more di�ult. Some attributed the problems to an over-familiarity withthe traditional planning proess, others to the irumstanes of the test, noting thatbeause they had to �rst plan in a traditional manner and then immediately tryto get into the alternative frame of mind needed for the new proess, the DynamiPlanning stage might seem arti�ially di�ult.Whatever the ause, this result indiates that are needs to be taken when dissem-inating and training the new approah. Users need to be given time and guidaneto alimatise to the new way of thinking. Additionally, the Dynami Planner itselfwill need to have a very omprehensive help faility, to provide both ontextual helpon the software funtionality and the proess itself. It might also be interesting torun some evaluations with ompletely inexperiened subjets who have not yet beentaught or used the traditional planning method. This possibility is disussed in theFurther Work setion.
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5.2 Evaluation of the Dynami PlannerThe Dynami Planner suessfully ahieved its primary aim � to provide users withthe ability to follow the Dynami Planning methodology and onstrut a plan aord-ingly. Although some features were not implemented that would be required werethe Planner intended to be used as a omplete planning pakage, what has beenimplemented proved su�ient to evaluate the methodology, as seen in the previoussetion.The proesses followed in onstruting the Dynami Planner were suessful as well.The ombination of the Extreme Programming and Test-Driven Development ap-proahes meant that a working version of the appliation was available at everystage, however limited its funtionality might have been. The approah to test-ing was espeially valuable, sine full testing after every user story implementationmeant that new bugs that were aidentally introdued were identi�ed lose to theirreation, making debugging in�nitely easier.Although in hindsight the seletion of Python and the wxPython GUI toolkit wasprobably still orret, there were some unantiipated problems when using the teh-nologies. Python itself is a simple and elegant language and was relatively easy tolearn. It is more often used for simple sripts than entire appliations, however, sothe learning urve was steep and the resoures available to learn from sparser thanif a more mainstream appliation development language (suh as Java) had beenseleted.wxPython, on the other hand, is quite omplex and su�ers from its origins � beauseit is essentially just a wrapper to the C++ wxWidgets library, wxPython program-ming is often quite di�erent from best pratie Python oding. Thus, in onstrutingthe Dynami Planner, it was neessary both to understand the Python idiom andthen to adjust to a more traditional approah when inluding wxPython ode.Another issue enountered when working with wxPython was related to its status.wxPython is an open-soure projet, sta�ed by volunteers. Lukily it is under veryative development, so there is an enthusiasti developer ommunity and a high-tra� mailing list where questions an be asked. Unfortunately the �ip side is thatthe doumentation is often pathy and the ative development means that there areoften hanges to the API (Appliation Programming Interfae).Development of the Dynami Planner began using the 2.4.2 release of wxPython,but it soon beame apparent that a number of the toolkit bugs being enounteredwould be solved by upgrading the toolkit. From then onwards, the 2.5.3 release wasused, but during the development time of this projet, there has been a new releaseof the toolkit on average every month. Sine eah release has subtle di�erenes inthe API and di�erent bugs, it was felt best to stay with the 2.5.3 release, sine theinitial upgrade had resulted in a great deal of ode needing to be refatored.How ever muh the upgrade helped with some problems, developing with wxPythonwas generally quite di�ult. Out-of-date doumentation meant that a number ofquestions had to be referred to the mailing list; the number of releases available thenmeant that multiple solutions needed to be explored before one that atually workedwas �nally found. 40



At the time of writing, however, a new stable release series (2.6) has just beomeavailable, whih inludes an API freeze. Hopefully this new release will make de-velopment with wxPython signi�antly easier, espeially as there is also a projetunderway to reate a new doumentation resoure. Ideally the planner should beonverted to run on this before any additional development is arried out.
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Chapter 6ConlusionThis projet has been a suess, with all the objetives being met. We have suess-fully applied various advanes in arti�ial intelligene planning to projet planning,ombining diret researh with dedution from bakground reading to produe a newapproah: Dynami Planning. This appears to be the �rst time that arti�ial intel-ligene planning approahes have been applied to projet management, although theopposite has happened in the past.Additionally, software to support this planning methodology has been developed andused in the evaluation of the e�ay of the approah. Initial results indiate thatDynami Planning is ertainly more �exible than traditional projet planning andpotentially also ontends extremely strongly in terms of the ability to trak projetprogress. A solid foundation has been provided to develop the Dynami Planner intoa piee of end-user software, as well as to test the Dynami Planning methodologyfurther.From a personal development point of view, I have learnt a great deal from under-taking this projet. The researh and aademi writing skills gained will de�nitelybe useful in future. Learning Python, wxPython and developing a desktop appli-ation for the �rst time were all hallenging tasks, but enjoyable at the same time.The knowledge and understanding of AI and projet planning has awakened a greatinterest in these and assoiated topis, whih I hope to pursue in future. I hope toontinue this work myself, as detailed in the Further Work setion whih follows.6.1 Further WorkIn this setion we will disuss the next steps if the work is to be ontinued. Firstlywe disuss potential next steps for the Dynami Planning methodology itself andthen the opportunities that exist for the planning software.6.1.1 Dynami Planning MethodologyThe �rst area that deserves further attention is that of researh and bakgroundreading. Sine the primary fous of this projet was the reappliation of AI planning42



advanes to projet management, these two areas direted the bakground readingand researh that was undertaken. However, during the ourse of the projet it hasbeome apparent that understanding the abilities of people is ruial in designing anappropriate methodology for �exible projet planning.Although are has been taken to base assumptions about people's behaviour andattitude to planning on the diret researh, it would also be worthwhile to ondutsome additional bakground reading in the areas of psyhology and ognitive siene.The intention here would be to validate underlying assumptions of the DynamiPlanning methodology, as well as identifying viewpoints that ould be brought to bearon the �exible planning problem. In partiular, investigations into the mental modelof planning and the emotional and thought proesses that our during planningould prove fruitful.As was noted when the methodology was originally set out, the fous has beenon the projet managers and the members of the projet teams. Although theirneeds have been well-represented and atered for, there are of ourse others whomake use of projet plans. The needs of stakeholders who are not diretly involvedin the projet teams, but nevertheless use the plans (for instane projet sponsors,external vendors or ustomers, et), must be investigated and the plan representationpotentially adjusted to make the plans as useful to them as to the projet teams.Additionally, the assumption was made during this projet that the Gantt hart wasthe optimal plan representation to be adapted for our use. This was based both on itsubiquity in the standard projet management texts, but also on the diret researharried out during the ourse of the projet. What this researh in fat showedwas that the Gantt hart is the most popular plan representation. This made itan obvious hoie for our use in a new methodology, sine when introduing newonepts it is often useful to tie them to very familiar ones. Nevertheless, additionalresearh to investigate whether the Gantt hart is in fat the best plan representationfor �exible planning still needs to be arried out.The initial evaluation of the Dynami Planning methodology was both useful and theresults enouraging, but muh remains to be done. Due to the obvious limitationsof evaluating in an experimental setting (only so muh an be done in an hour, afterall!), the potential of this approah has only been touhed upon. Additional testingand evaluation is de�nitely needed and the following should be investigated:
• Testing with di�erent groups of users. The evaluation already arried out wasdone by a mixed group of relatively inexperiened projet planners. It wouldbe interesting to arry out similar evaluations with ompletely inexperienedstudents, to see if they understand and adopt the methodology more readily,not having already learnt and used the traditional approah. Testing withexperiened projet managers would also be desirable, beause they may bebetter plaed to evaluate the true usefulness of the approah, based on theirpast experiene.
• Testing in the real world. Sine the Dynami Planning methodology is designedto help projet managers deal with the unertain nature of the world, thenext logial step is to test it in this environment. However useful testing the43



approah experimentally may be from an aademi viewpoint, the true test ofa planning approah will be when it is being used for the entirety of a realprojet. Making this possible should be the eventual aim of any further work.Carrying out this kind of testing of ourse requires the Dynami Planner as support.Additional work to be arried out in developing this software must therefore bedisussed next.6.1.2 Dynami PlannerSine the requirements eliitation extended beyond the basi funtionality needed toperform the initial evaluation of the Dynami Planning methodology, the roadmap fordevelopment has already been drawn. Although to perform the testing with di�erentgroups of users desribed above, little additional development would be neessary, inorder to release the methodology into the real world and test its use in real projets,signi�antly more work needs to be ompleted on the Dynami Planner.Firstly, a number more features need to be implemented. The most ruial of thesein terms of the methodology support are of ourse the provision of various levels ofmilestone (i.e. sub-milestones, miniature milestones, et, in a hierarhy), the abilityto swith time dimensions (allowing for a steady progression from a low-preisiontowards higher-preision versions of a plan) and the provision of olour-oding forthe milestone bars. There are of ourse other features that are not essential to themethodology, but useful or required in a business setting nonetheless.An obvious example is the ability to export plans to alternative formats, so that theyan be viewed by users who do not have the Dynami Planner installed. The softwarehas been implemented with this in mind � sine the plan data is stored separately innative Python data strutures, pulling this data out into an alternative format (forinstane, HTML or PDF or CVS) should be relatively easy. Various other featuresare also detailed in the full Requirements doument found in the appendies.During the implementation of the fuller feature set, it would be prudent to engage inusability evaluations, to ensure that the interfae being implemented is intuitive andin line with Human Computer Interation best pratie. An expert evaluation of theinterfae would be a useful �rst step, to identify any major problems, and thereaftera user-entred design approah should be employed.From a tehnial point of view, the Dynami Planner needs to be adapted to use thenewly released 2.6 series of the wxPython GUI toolkit. Sine the API for this releasehas been frozen, ongoing development should be muh easier and more preditable.Additionally, the urrent ode was written for Python 2.3, but sine 2.4 is the lateststable version, it may also be worth updating the software to this newer version andtaking advantage of any new funtionality or speed enhanements.Finally, in order to distribute the Dynami Planner more widely, more easily instal-lable versions are required. Currently to run the software, the user must alreadyhave installed both Python (2.3) and wxPython (2.5.3) separately. Although thanksto the work of both development ommunities, installing Python and wxPython is44



remarkably easy, it is still not wise to expet users to manage software dependenieson their own.For this reason, reating a Windows .exe �le, Ma app folder and Linux pakagefor the Dynami Planner would be useful. There are existing tools that make thisproess easy. py2exe is a tool for reating Windows binaries that ontain all Pythonmodules needed for the appliation in one exeutable. py2app and bundlebuilderare similar utilities for reating standalone binaries for Maintosh. For Linux thefreeze utility inluded with Python may su�e, but in order to promote wider use itwould probably be wise to supply Debian .deb arhives, Red Hat RPMs and similarpakages for the other popular Linux distributions.
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Appendix AReview of Existing SystemsAs existing planning methodologies were examined, it was important to be onsiousof the existing software available to support these proesses. One the DynamiPlanning approah had been developed, it was important to identify whether existingsoftware ould support planning in this way. For this reason existing software wasreviewed and the synopsis is inluded here for ompleteness.A.1 MS ProjetMS Projet is like a Swiss army knife of projet planning. It an produe virtuallyany form of projet plan, from Gantt harts (the default view) through to resourelevelling views, task lists to network diagrams. In many ways this represents overkillfor the average projet. The interfae, although reasonably user-friendly, does notinvite the user to plan with the system. In pratie, many users report that theyplan on paper or in other simpler tools (suh as Exel) and then input their plansinto MS Projet to display the appropriate format. The high degree of help anduser guidane that MS Projet provides also suggests that it is not intuitive enoughto be used as a planning tool in the oneptual stage of a projet, just as a planrepresentation tool later in the proess.MS Projet does provide a number of useful sheduling aids � for instane, it willautomatially de�ne start and end dates if given duration and dependeny informa-tion � but these are only useful when produing high preision plans. Indeed, theamount of detail needed about onstraints in fat an hamper the planning proess,sine in order to produe even an outline plan arbitrary task lengths and deadlinesmust be input. This an lead to very preise (but inorret) plans being drawn up atthe projet outset and an only ontribute to the early ommitment issues desribedby DeMaro [2002℄.A.2 Open Soure AlternativesThere are a number of open soure projet management tools available for download.For the most part these tend to mimi the funtionality provided by MS Projet,50



usually in three main areas: task lists, Gantt harts and resoure utilisation & level-ling diagrams. The following appear to provide similar (if more limited) funtionalityto MS Projet in these areas:
• Mr Projet (http://mrprojet.odefatory.se/)
• JXProjet (http://www.jxprojet.om/)
• QtGantt (http://www.gumbley.me.uk/qtgantt.html)
• Open Workbenh (http://www.openworkbenh.org/)
• Gantt Projet (http://ganttprojet.soureforge.net/)Although arguably these (and various other similar programs) are doing well torepliate the most useful funtionality from MS Projet, there is a de�nite gap withregards to software for alternative planning approahes. At the moment UML ordiagram drawing tools (suh as Dia) ould be used to produe Milestone Plans butno urrent projet planning software appears to do so urrently.Sine all the existing tools mimi MS Projet and share its fous on task-basedpreision ativity planning, none an be used in a manner that supports DynamiPlanning. For this reason it was essential to develop a new appliation (the DynamiPlanner), spei�ally to support the new planning methodology.

51



Appendix BRequirements DoumentThis requirements douments onsists primarily of User Stories, brief desriptions offuntionality as enountered by a user of the system. This method of requirementsrepresentation was felt to be appropriate for two key reasons. Firstly, sine there wasno real ustomer for the system, a detailed requirements doument was not neededto at as a basis of understanding between developer and ustomer. Seondly, thesoftware was developed as a vehile for testing the Flexible Projet Planning method-ology and so the priority was to support the planning proesses of this methodology.The doument enlosed here overs all requirements set out during the ourse ofthe projet. Some of these were not implemented, for reasons disussed in the maindissertation.B.1 High-Level Requirements1. Provide support for plan prodution using the Results-Foused Planning method-ology(a) Allow plans to be onstruted from milestones(b) Allow plans of various levels of preision, as appropriate to the projetstage() Display the plan graphially, in a similar style to a Gantt hart(d) Failitate easy editing and updating of the plan(e) Failitate progress traking and timely issue identi�ation2. Software must be ross-platform, able to run on any of the three major plat-forms (Windows, Ma, *nix), so that eventually it an be distributed and testedby a wider audiene3. Software should be user-friendly and intuitive, requiring minimal training toonstrut plans4. It must be possible to share plans between users and stakeholders52



B.2 User StoriesBasi Funtionality1. User opens the appliation and is greeted with a blank plan2. User adds a milestone by entering a milestone desription and due date [theuser may also indiate a duration � if not, duration is assumed to be 1 unit oftime℄3. User edits an existing milestone by seleting it and editing one of its attributesdiretly4. User deletes an existing milestone by seleting Delete Row from the Edit menu5. User inserts a new row (and milestone) by seleting Insert Row from the Editmenu6. User views the plan [whih is in fat ontinuously updated and visible, as themilestone data is entered and edited by the user℄7. User adds a note to a milestone8. User saves the plan to disk9. User opens a plan from disk10. User exits the appliationIntermediate Funtionality1. User prints the plan2. User exports the plan to an alternative format [HTML, XML or PDF, forinstane℄3. User hanges the hierarhy level of a milestone [i.e. making it a sub-milestone,or a sub-sub-milestone, or the reverse℄4. User requests and reeives general help on the methodology and the softwareAdvaned Funtionality1. User hanges time dimension [to move plan from being low-preision (e.g. ex-pressed against quarters) to a higher preision plan (e.g. expressed againstmonths or weeks) � the system should auto-onvert the milestone data appro-priately℄2. User selets a partiular olour for a milestone [a shortlist of frequently usedolours should be available on the toolbar for easy aess℄3. User requests and reeives ontext-sensitive help on either the methodology orthe software 53



Appendix CTest SriptsAlthough Unit Testing was an appropriate vehile for testing the data storage aspetof the appliation (i.e. the Model), all the other funtionality required user inter-ation and so an alternative testing method was required. This onsisted primarilyof sripted user testing. The sripts used during this testing are inluded here forompleteness.User Story Test Desription StatusAdd A Milestone Enter milestone desription :: ensure that nohange is made to Gantt hart PassEnter milestone desription, due date :: ensurethat Gantt hart is updated with milestone baragainst due date PassEnter milestone desription, due date, duration:: ensure that Gantt displays milestone bar thatspans the number of time periods indiated bythe duration with the right-hand edge againstthe due date Pass
Edit A Milestone Edit milestone desription :: ensure that nohange is made to Gantt hart PassEdit due date :: ensure that Gantt hart is up-dated with milestone bar against newly inputteddue date PassEdit duration :: ensure that Gantt hart is up-dated with milestone bar that spans the numberof time periods indiated by the duration, withthe right-hand edge against the due date PassInsert a Row Selet Insert Row from the Edit menu :: ensurethat row is added where the ursor lies, to boththe data input grid and the Gantt hart grid Pass54



User Story Test Desription StatusSelet a row in the data input grid and then se-let Insert Row from the Edit menu :: ensurethat row is added at point where row was se-leted and not where ursor lies Pass
Delete a Row Selet Delete Row from the Edit menu :: ensurethat the row where the ursor lay is deleted PassSelet a row in the data input grid and thenselet Insert Row from the Edit Menu :: ensurethat the row whih was seleted is deleted (andnot the row where the ursor lay) PassView Plan Ensure that the data entry grid and ontainedinformation is visible PassEnsure that the Gantt hart aurately re�etsthe information in the data input grid and isvisible PassOpen From File Selet Open from the File menu :: ensure thatOpen File... dialog appears PassSelet a �le in the Open File... dialog and likOK :: ensure that the plan data is loaded su-essfully PassWith a �le already open, selet Open from Filemenu, hoose another �le :: ensure that the ur-rent information is leared and replaed with thenewly loaded data PassSave To File Create a new plan and selet Save from the Filemenu :: ensure that the Save As... dialog ap-pears PassOpen an existing plan, edit it, then selet Savefrom the File menu :: ensure that �le is atuallysaved and that save on�rmation dialog appears Pass
Add a Note to aMilestone Add a note in the Note �eld of the milestone ::ensure it is displayed Pass
Exit theAppliation Selet Quit from the File menu :: ensure thatthe appliation loses Pass
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User Story Test Desription StatusShortuts Work For eah shortut, perform the shortut key se-quene :: ensure that the same funtionality isevident as if the menu option had been hosendiretly Pass
Print the Plan Selet Print from the File menu :: ensure thatthe plan is sent to the printer Fail
Export the Plan Selet Export from the File menu :: ensure that�le dialog is displayed, allowing user to speifythe �le format FailOne �le has been exported :: hek that ex-ported data mathes urrent plan FailInreaseHierarhy Levelof a Milestone Whilst ursor or seletion is on an existing mile-stone, selet Inrease Indent from Edit menu ::ensure that milestone desription is preeded byappropriate dashes to show it is a sub-milestone Fail

Whilst ursor or seletion is on a blank row,selet Inrease Indent from Edit menu :: ensurethat milestone desription is preeded by appro-priate dashes to show it is a sub-milestone FailWhilst ursor is in milestone desription, typean even number of dashes to indiate hierarhylevel :: ensure that the saved data re�ets theappropriate milestone hierarhy level Fail
DereaseHierarhy Levelof a Milestone Whilst ursor or seletion is on an existing mile-stone, selet Derease Indent from Edit menu ::ensure that milestone desription has 2 dashesremoved from the start Fail
Request ContextSensitive Help Perform a task and selet Help With This fromthe Help menu :: ensure that ontext-sensitivehelp is displayed Fail
Request GeneralHelp Selet Help from the Help menu :: ensure thatgeneral help information is shown Fail
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User Story Test Desription StatusChange TimeDimension With an existing plan, selet Change TimeDimension from the Edit menu :: ensure thatChange Time Dimension dialog is displayed Fail
In the Change Time Dimension dialog, selet anew time dimension :: ensure that appliationappearane, plan data and plan graph are allonverted to the new dimension FailDerease preision of time dimension :: ensurethat the more preise data is still stored and thatthe appliation onverts only for display Fail

Colour aMilestone Press button in the Colour olumn alongside anexisting milestone :: ensure that Colour ChooserDialog is displayed Fail
In Colour Chooser Dialog, selet a olour :: en-sure that plan is updated to show milestone inthat olour and that olour information is storedinternally FailEnsure that in Colour Chooser Dialog, fre-quently used olours are easily seletable FailEnsure that in the Colour Chooser Dialog, useran de�ne their own olours FailRun Appliationon Any Platform Run the appliation on Windows :: ensure thatall tests pass Pass
Run the appliation on Linux :: ensure that alltests pass PassRun the appliation on Maintosh :: ensure thatall tests pass FailDistribute theAppliation toAny Platform Ensure that an easy method of installing andrunning the appliation is available for Windows,Linux and Maintosh Fail

As mentioned in the main body of this dissertation, the data lasses of the appliationwere tested using built in unit tests. A sreenshot of the test results an be found inFigure C.1 on the following page. 57



Figure C.1: Plan Data Test Results
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Appendix DDynami Planner SreenshotsIn the following pages, a number of sreenshots of the Dynami Planner are presented,running under both Linux and Windows. Unfortunately a Maintosh omputer wasnot available to test the software under.
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Figure D.1: Main Sreen, running on Linux60



Figure D.2: About Dialog, running on Linux61



Figure D.3: Save As Dialog, running on Linux62



Figure D.4: Save Con�rmation, running on Linux63



Figure D.5: Main Sreen, running on Windows64



Figure D.6: File Menu (example of menus), running on Windows65



Figure D.7: Open Dialog, running on Windows66



Appendix EEvaluation Results
Question Key ResultsHow easy do you think the Gantthart you onstruted will be tofollow? 4/6 say easy to follow
How useful do you think the Gantthart you onstruted will be fortraking progress during theprojet? 5/6 say not very useful
Do you think the Gantt hart youonstruted would be followed? All say unlikely to befollowed, with variousstrength in thestatementHow easy was the Dynami Plan toonstrut? 3 say easy to onstrut,3 express that it wassomewhat di�ultIf you did not �nd it easy toonstrut, why do you think this is? All agree the issue is inthe hange of paradigmfrom task-based toresult-based thinking67



Question Key ResultsDo you think this plan will be moreor less easy to follow than thetraditional Gantt hart? All feel easier to follow
Do you think this plan will be moreor less useful for traking progressthan the traditional Gantt hart? All feel dynami planmuh more useful forprogress trakingWhih plan was easier to update?(given the signi�ant hange) 6/6 found the dynamiplan easier to updateIf this situation had ourred inyour work environment, do youthink the traditional plan wouldhave been updated? Only one respondentfelt they would haveupdated the originalplanDo you think using the DynamiPlanning method would make youmore likely to keep your plansup-to-date? 6/6 say yes

68



Appendix FCode Listings
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1 from pickle import *
2

3 """

4 Part of the framework for the Dynamic Planner planning software

5 Produced by Meri Williams for CM30076 (Final Year Project)

6

7 Author: Meri Williams

8 Version: 1.1

9 """

10 class planData:
11 """Holds the plan data, storing both the text input by the user into the right-hand grid

12 and the other information stored by the system about the displayed plan (e.g. colour,

13 submilestone level, etc). The data stored here should mirror additions and changes

in

14 the milestone information and the plan itself.

15

16 The data stored is what is needed to construct the graphical plan, not the graph

17 itself

18

19 When run as a standalone .py file (python planData.py), a series of unit tests are

20 executed and the results displayed"""

21

22 def init (self):
23 """Constructor initializes array to hold the rows (dictionary structures) of the plan

24 data"""

25 self.data = []

26

27 def getNumRows(self):
28 """Returns the number of rows stored in the planData instance"""

29 return len(self.data)
30

31 def addRow(self, rowData):

32 """Adds the given row of data to the end of the list"""

33 self.data.append(rowData)
34

35 def insertRow(self, rowNo, rowData):

36 """Inserts the given row of data at the index specified"""

37 if rowNo < len(self.data):
38 self.data.insert(rowNo, rowData)

39 else:

40 print "Sorry, cannot add value at that index"

41

42 def editRow(self, rowNo, rowData):

43 """Edits the given row, replacing existing data with that which is supplied, else

44 creating a new row at the end"""

45 if rowNo < len(self.data):
46 self.data[rowNo] = rowData

47 else:

48 self.addRow(rowData)
49

50 def fetchRow(self, rowNo):

51 """If the row exists (i.e. rowNo < number of rows), returns the value stored at

52 rowNo index. Otherwise returns False"""

53 if rowNo < len(self.data):

1



54 return self.data[rowNo]
55 else:

56 print "Sorry, that row does not exist"

57 return False

58

59 def clearRow(self, rowNo):

60 """Clears the value of the given row, setting it to an empty string "" """

61 if rowNo < len(self.data):
62 self.data[rowNo] = ""

63 else:

64 print "Sorry, that row does not exist and so cannot be cleared"

65

66 def deleteRow(self, rowNo):

67 """Deletes the row from the list entirely (removing the object stored there)

68

69 Returns the object that was stored there, or False if the row did not exist"""

70 if rowNo < len(self.data):
71 return self.data.pop(rowNo)
72 else:

73 return False

74

75 def saveToFile(self, filename):

76 """Saves the planData object to a file called filename, as a serialized object

77 using Pickle.

78

79 Returns true if successful, false if any exceptions are raised"""

80 try:

81 savefile = open(filename, 'w')

82 saver = Pickler(savefile)

83 saver.dump(self)
84 savefile.close()

85 return True

86 except IOError, PickleError:

87 print "Failed to save to file"

88 return False

89

90 def loadFromFile(self, filename):

91 """Loads a file from filename, returning the planData object"""

92 try:

93 loadfile = open(filename, 'r')

94 loader = Unpickler(loadfile)

95 plan = loader.load()

96 loadfile.close()

97 return plan

98 except IOError, PickleError:

99 print "Failed to open file"

100 return False

101

102 def printAllRows(self):
103 """Prints out all the data stored in each row in a human-readable form.

104 Primarily for debugging purposes"""

105 for i in range(0, len(self.data)):
106 print "Line", i, "::", self.fetchRow(i)
107
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108 if name == " main ":

109 """Series of unit tests to ensure that functionality is working as required.

110

111 These will be executed when run as a standalone file (i.e. >> python planData.py)"""

112 # Initial result values to ensure no false positives
113 rowAdded = False

114 rowEdited = False

115 nonexistentRowEdited = False

116 rowCleared = False

117 rowDeleted = False

118 fileSaved = False

119 fileOpened = False

120 PROBLEM = False

121 rowsCounted = False

122 testsPassed = 0

123

124 testplan = planData()

125 #test adding a row
126 testplan.addRow(10)

127 if testplan.fetchRow(0) == 10:

128 rowAdded = True

129 testsPassed += 1

130 #test editing a row
131 testplan.editRow(0, 11)

132 if testplan.fetchRow(0) == 11:

133 rowEdited = True

134 testsPassed += 1

135 testplan.editRow(3, 20)

136 if testplan.fetchRow(1) == 20:

137 nonexistentRowEdited = True

138 testsPassed += 1

139 #test deleting a row
140 testplan.clearRow(0)

141 if testplan.fetchRow(0) == "":

142 rowCleared = True

143 testsPassed += 1

144 compare = testplan.fetchRow(1)

145 testplan.deleteRow(0)

146 if testplan.fetchRow(0) == compare: #comparing to value of what used to be at index 1
147 rowDeleted = True

148 testsPassed += 1

149 #test exporting to savefile
150 testplan.addRow(f'name':'meri', 'age':22g)

151 testplan.addRow(f'name':'elly', 'age':23g)

152 if testplan.saveToFile('savetest.txt'):

153 fileSaved = True

154 testsPassed += 1

155

156 #test importing from savefile
157 loadtest = planData()

158 extratest = planData()

159 extratest.addRow(46664)

160 loadtest = testplan.loadFromFile('savetest.txt')

161 if loadtest.fetchRow(1) == testplan.fetchRow(1):
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162 fileOpened = True

163 testsPassed += 1

164 if loadtest.fetchRow(0) == extratest.fetchRow(0):

165 PROBLEM = True

166 testsPassed -= 1

167 else:

168 testsPassed += 1

169 if extratest.getNumRows() == 1:

170 rowsCounted = True

171 testsPassed += 1

172

173 print "TEST RESULTS:"

174 print "Row added: ", rowAdded

175 print "Row edited: ", rowEdited

176 print "Nonexistent row edited: ", nonexistentRowEdited

177 print "Row cleared: ", rowCleared

178 print "Row deleted: ", rowDeleted

179 print "File saved: ", fileSaved

180 print "File opened again: ", fileOpened

181 print "Rows counted: ", rowsCounted

182 print "Do we have a problem? ", PROBLEM

183 print "Number of tests passed: ", testsPassed

184

185 print "TESTPLAN:"

186 testplan.printAllRows()

187 print "LOADTEST:"

188 loadtest.printAllRows()

189 print "EXTRATEST:"

190 extratest.printAllRows()
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1 import wxversion
2 wxversion.select('2.5.3') # Selects the version of wxPython to use (multi-versions poss)
3 import os
4 from wxPython.wx import *
5 from wxPython.grid import *
6 from planData import *
7

8 """

9 Dynamic Planner GUI classes

10 Contains View & Controller aspects of the application

11 Produced by Meri Williams for CM30076 (Final Year Project)

12

13 Author: Meri Williams

14 Version: 2.1

15 """

16

17 # wxNewId() gives unique identifier to each of the constants, for this run of the program
18 ID ABOUT=wxNewId()

19 ID SAVE=wxNewId()

20 ID SAVE AS=wxNewId()

21 ID OPEN=wxNewId()

22 ID INSERT ROW=wxNewId()

23 ID DELETE ROW=wxNewId()

24 ID INCREASE INDENT=wxNewId()

25 ID DECREASE INDENT=wxNewId()

26 ID NEW=wxNewId()

27 ID CLOSE=wxNewId()

28 ID EXIT=wxNewId()

29 ID HELP=wxNewId()

30 ID PRINT=wxNewId()

31 ID EXPORT PDF=wxNewId()

32

33 # Constants to make it easier to adapt the GUI
34 MILESTONE LABEL = "Milestone"

35 ENDTIME LABEL = "Due"

36 ESTIMATE LABEL = "Duration"

37 NOTE LABEL = "Notes"

38

39 # Some hard-coded values to assist in a simple time plan
40 INITIAL ROWS = 100

41 INITIAL COLS = 12

42 year = ["Jan", "Feb", "Mar", "Apr", "May", "Jun", "Jul", "Aug", "Sep", "Oct", "Nov", "Dec"]

43

44 # MAIN GUI CODE =========================================================================
45 class PlannerGUI(wxFrame):
46 """The primary class that provides the Graphical User Interface for the planning

47 application, encompassing both the View and Controller aspects of the architecture.

48

49 The init function prepares the interface, creating the menus, key widgets and so

50 on (i.e. the View) and binding events to associated functions

51

52 A variety of functions containt the actual functionality of the interface, forming

53 the Controller aspect of the architecture. Uses the planData class to handle the

54 application data (i.e. the Model)"""
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55 def init (self,parent,id,title):
56 """Creates the interface, building up the widgets to form the GUI and associates

57 events with event handling functions"""

58 # first call the parent constructor
59 wxFrame. init (self,parent,wxID ANY, title, size=wxDefaultSize ,style=wxDEFAULT FRAME STYLEjwxNO FULL REPAINT ON RESIZE)

60 self.CreateStatusBar() # A StatusBar in the bottom of the window
61

62 # MENU CODE ------------------------------------------------------
63 # Create the menus
64 filemenu = wxMenu()

65 editmenu = wxMenu()

66 helpmenu = wxMenu()

67 # Add the menu items, shortcuts and their status bar info strings
68 # NOTE:nt denotes the keyboard shortcut
69 filemenu.Append(ID NEW, "&NewntCtrl+N"," Create a new plan")

70 filemenu.Append(ID OPEN, "&OpenntCtrl+O", " Open an existing plan")

71 filemenu.Append(ID SAVE, "&SaventCtrl+S", " Save the current plan")

72 filemenu.Append(ID SAVE AS, "Save &As...", " Save the current plan")

73 filemenu.Append(ID CLOSE, "&Close", " Close the current plan")

74 filemenu.AppendSeparator()

75 filemenu.Append(ID PRINT, "&Print", " Print the current plan")

76 filemenu.Append(ID EXPORT PDF, "&Export to PDF", " Export the current plan to PDF")

77 filemenu.AppendSeparator()

78 filemenu.Append(ID EXIT,"E&xitntCtrl+Q"," Terminate the program")

79

80 editmenu.Append(ID INSERT ROW, "&Insert a Row", " Insert a row")

81 editmenu.Append(ID DELETE ROW, "&Delete Row", " Remove the selected row")

82 editmenu.Append(ID INCREASE INDENT, "&Increase Indent", " Increase indentation to allow

submilestones")

83 editmenu.Append(ID DECREASE INDENT, "D&ecrease Indent", " Decreases indentation")

84

85 helpmenu.Append(ID ABOUT, "&About"," Information about this program")

86 helpmenu.Append(ID HELP, "&Help", " Help using this program")

87

88 # Create the menu bar and then add the menus to it
89 menuBar = wxMenuBar()

90 menuBar.Append(filemenu,"&File")

91 menuBar.Append(editmenu, "&Edit")

92 menuBar.Append(helpmenu, "&Help")

93

94 self.SetMenuBar(menuBar) # Adding the MenuBar to the overall Frame
95 self.splitter = wxSplitterWindow(self, -1) # Creates a splitter window (div in 2)
96

97 # GRID STUFF ------------------------------------------------------
98 # Create the input grid and do some formatting
99 self.grid = wxGrid(self.splitter,-1)
100 self.grid.CreateGrid(INITIAL ROWS,4)

101 self.grid.SetColLabelValue(0, MILESTONE LABEL)

102 self.grid.SetColLabelValue(1, ENDTIME LABEL)

103 self.grid.SetColLabelValue(2, ESTIMATE LABEL)

104 self.grid.SetColLabelValue(3, NOTE LABEL)

105

106 # Create specific attributes so that only relevant values can be entered in certain columns
107 endTimeAttr = wxGridCellAttr()
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108 endTimeAttr.SetEditor(wxGridCellChoiceEditor(year)) # makes the editor for cells a drop-
down list
109 self.grid.SetColAttr(1, endTimeAttr)

110

111 estimateAttr = wxGridCellAttr()

112 estimateAttr.SetEditor(wxGridCellNumberEditor())

113 self.grid.SetColAttr(2, estimateAttr)

114

115 self.grid.SetMargins(0,0)
116 #self.grid.SetRowLabelSize(0)
117 #self.grid.AutoSize() # fits the grid to the column & row labels
118 self.grid.SetColSize(0,250)
119 self.grid.SetColSize(1,100)
120

121 self.plan = wxGrid(self.splitter, -1)

122 self.plan.CreateGrid(INITIAL ROWS, INITIAL COLS)

123 for i in range(0,INITIAL COLS):

124 self.plan.SetColLabelValue(i, year[i])

125

126 self.plan.SetMargins(0,0)
127 self.plan.SetRowLabelSize(0)
128 self.plan.SetDefaultColSize(50)
129 self.plan.EnableEditing(False)
130 self.plan.EnableGridLines(True)
131 self.splitter.SetMinimumPaneSize(100)
132 self.splitter.SplitVertically(self.grid, self.plan, 600)

133 self.splitter.Fit()
134

135 # SIZER CODE ------------------------------------------------------
136 self.sizer = wxBoxSizer(wxHORIZONTAL)

137 self.sizer.Add(self.splitter,1,wxEXPAND)
138 self.SetSizer(self.sizer)
139 self.SetAutoLayout(1)
140 self.sizer.Fit(self)
141

142 # EVENTS CODE -----------------------------------------------------
143 # Binds events to the functions that should be called when they occur
144 EVT MENU(self, ID OPEN, self.OnOpen)
145 EVT MENU(self, ID SAVE, self.OnSave)
146 EVT MENU(self, ID SAVE AS, self.OnSaveAs)
147 EVT MENU(self, ID EXIT, self.OnExit)
148 EVT MENU(self, ID INSERT ROW, self.OnInsertRow)
149 EVT MENU(self, ID DELETE ROW, self.OnDeleteRow)
150 EVT MENU(self, ID ABOUT, self.OnAbout)
151 EVT GRID CELL CHANGE(self, self.OnCellChange)
152 EVT KEY DOWN(self.grid, self.OnKeyDown)
153

154 self.Show(true)
155 print(self.splitter.GetBestSize()) #DEBUG
156 """ NOTE: The GetBestSize function is returning inappropriate results at the moment

157 This is a bug in wxPython itself. The workaround used is that the application

158 immediately maximises itself when loaded. An upcoming release of wxPython may

159 include a fix and so ideally the software should eventually be upgraded"""

160 self.Maximize()
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161

162 # Initialise some of the key variables that will be used by the program
163 self.plandata = planData()

164 self.savepath = ""

165

166 # EVENT HANDLER RESPONSES =========================================================
167 def OnSave(self,evt):
168 """ When the user selects Save (either using Ctrl-S shortcut or the menu, then

169 the application first identifies whether there is an existing savepath (i.e.

170 whether there is already a file open).

171

172 If this is the case, then the updated plan is saved to the file already open and

173 a confirmation is shown that the file has been saved successfully.

174

175 If the plan has not already been saved, the Save As response is called."""

176 if self.savepath != "":

177 self.plandata.saveToFile(self.savepath)
178 #print ”Saved to file”
179 saveConfirm = wxMessageDialog( self, " File successfully saved!","File Saved!",

wxOK)

180 saveConfirm.ShowModal()

181 saveConfirm.Destroy()

182 else:

183 self.OnSaveAs(evt)
184

185 def OnSaveAs(self, evt):

186 """Creates a file chooser dialog for the user to choose where they would like to

187 save their file. The user can choose to view either just dynamic plans or all

188 files. Once a filename has been chosen, the plan data is saved."""

189 wildcard = "Dynamic plan (*.plan)j*.planj" n

190 "All files (*.*)j*.*"

191 savedialog = wxFileDialog(self, message="Save file as...", defaultDir=os.getcwd(),

192 defaultFile="", wildcard=wildcard, style=wxSAVE)

193 if savedialog.ShowModal() == wxID OK:

194 self.savepath = savedialog.GetPath()

195 print('You selected "%s"'% self.savepath)
196 diditsave = self.plandata.saveToFile(self.savepath)
197 print "Just tried to save to file"

198 print "Successfully saved? ", diditsave

199 self.plandata.printAllRows()
200 savedialog.Destroy()

201

202 def OnOpen(self, evt):

203 """Creates a file dialog for the user to choose the file they wish to open. If

204 the user selects a file, then it is loaded and the plan data is displayed"""

205 wildcard = "Dynamic plan (*.plan)j*.planj" n

206 "All files (*.*)j*.*"

207 openfiledialog = wxFileDialog(self, "Please choose file to open", os.getcwd(), "",

wildcard, wxOPEN)

208 if openfiledialog.ShowModal() == wxID OK:

209 openpath = openfiledialog.GetPath()

210 #clear the internal storage and wipe the grids clean before loading
211 self.plandata = planData()

212 for row in range (0, self.grid.GetNumberRows()):
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213 self.clearRow(self.grid, row)

214 self.clearRow(self.plan, row)

215 self.plandata = self.plandata.loadFromFile(str(openpath)) #load the plan data
216 self.savepath = openpath #update the savepath to the file just opened
217 self.loadPlanData()
218 openfiledialog.Destroy()

219

220 def OnAbout(self,evt):
221 """ When the About menu option is selected, this function displays a

222 small dialog to give some basic information about the software"""

223 aboutMessage = wxMessageDialog( self, " Dynamic Planner nn"

224 " n"Flexible Planning in a Changing Worldn" nn nn"

225 " Provides basic support for the nn"

226 " Dynamic Planning Methodology developed nn"

227 " by Meri Williams & Joanna Bryson","About", wxOK)

228 aboutMessage.ShowModal()

229 aboutMessage.Destroy()

230

231 def OnExit(self,evt):
232 """ Closes the application when Exit is selected from the File Menu"""

233 self.Close(True)
234 """NOTE: This should be updated to eventually check if the user has saved what

235 they have been working on and if not to prompt them to do so"""

236

237 def OnInsertRow(self,evt):
238 """Inserts a row into the data and plan grids. Where the row is inserted depends

239 on where the cursor is or what row/cells the user has selected. Selection

240 takes precedence over simple cursor position"""

241 blankrow = f'milestone':"", 'due':"", 'estimate':"", 'owner':""g

242 if self.grid.IsSelection():
243 selectedrows = self.grid.GetSelectedRows()
244 row = selectedrows[0]

245 else:

246 row = self.grid.GetGridCursorRow()
247 self.grid.InsertRows(pos=row, numRows=1, updateLabels=True)

248 self.plandata.insertRow(row, blankrow)

249 self.plan.InsertRows(pos=row, numRows=1, updateLabels=True)

250

251 def OnDeleteRow(self, evt):

252 """Deletes a row from the data and plan grids. Which row is deleted depends

253 on where the cursor is or what row/cells the user has selected. Selection

254 takes precedence over simple cursor position"""

255 if self.grid.IsSelection():
256 selectedrows = self.grid.GetSelectedRows()
257 row = selectedrows[0]

258 else:

259 row = self.grid.GetGridCursorRow()
260 self.grid.DeleteRows(pos=row, numRows=1, updateLabels=True)

261 self.plandata.deleteRow(row)
262 self.plan.DeleteRows(pos=row, numRows=1, updateLabels=True)

263

264 def OnCellChange(self,evt):
265 """Is called when a cell is edited by the user.

266
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267 Updates the graphical plan based on the data the user has input into the data grid

268 on the left hand side"""

269 row = evt.GetRow()

270 self.storeRow(row)
271 self.plandata.printAllRows()
272 self.repaintRow(row)
273

274 def OnKeyDown(self, evt):

275 """Remaps the enter key, so that if editing a row, the cursor moves right

276 when enter is pressed and if at the end of the row, jumps to the beginning

277 of the next row.

278

279 Adapted from the demo code supplied with wxPython"""

280 if evt.KeyCode() != wx.WXK RETURN:

281 if evt.KeyCode() == wx.WXK DELETE:

282 # Placeholder: should remap Del to clear row if row is selected (TODO)
283 evt.Skip()

284 return

285 evt.Skip()

286 return

287 if evt.ControlDown(): # the edit control needs this key
288 evt.Skip()

289 return

290 self.grid.DisableCellEditControl()
291 success = self.grid.MoveCursorRight(evt.ShiftDown())
292 if not success:

293 newRow = self.grid.GetGridCursorRow() + 1

294 if newRow < self.grid.GetTable().GetNumberRows():
295 self.grid.SetGridCursor(newRow, 0)

296 self.grid.MakeCellVisible(newRow, 0)

297 else:

298 # this would be a good place to add a new row if your app
299 # needs to do that
300 pass

301

302 # HELPER METHODS ==============================================================
303 def clearRow(self, whichgrid, row):

304 """Clears the plan row of any existing graph data, so new can be painted"""

305 for col in range(0, whichgrid.GetNumberCols()):

306 whichgrid.SetCellBackgroundColour(row, col, wxWHITE)

307 whichgrid.SetCellValue(row, col, "")

308

309 def repaintRow(self, row):

310 """Repaints the plan row, to reflect changes the user has made

311

312 This is the key Controller method for updating the displayed plan based on

313 changed to the Model"""

314 self.clearRow(self.plan, row)

315 estimate = self.grid.GetCellValue(row, self.findColumnIndex(self.grid, ESTIMATE LABEL))

316 endTime = self.grid.GetCellValue(row, self.findColumnIndex(self.grid, ENDTIME LABEL))

317 endTimeCol = self.findColumnIndex(self.plan, endTime)

318 # Tries to get estimate value, but if this fails defaults to 1
319 try:

320 estimate = int(estimate)
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321 except ValueError:
322 print("Couldn't convert to int, setting estimate to 1")

323 estimate = 1

324 if isinstance(estimate, int):
325 if (estimate > 0) and (endTimeCol != False):

326 for i in range(estimate):
327 self.plan.SetCellBackgroundColour(row, endTimeCol-i, wxGREEN)

328 self.plan.ForceRefresh()
329

330 def findColumnIndex(self, whichgrid, label):

331 """Finds the number of the column with the supplied label"""

332 numCols = whichgrid.GetNumberCols()

333 for i in range (0, numCols):

334 if label == whichgrid.GetColLabelValue(i):

335 return i

336 return False

337

338 def storeRow(self, row):

339 """Stores the row information as a dictionary in the planData object"""

340 rowContents = fg

341 #NOTE: TODO update so these call the findcolindex function instead of hardcoded
342 rowContents["milestone"] = str(self.grid.GetCellValue(row, 0))

343 rowContents["due"] = str(self.grid.GetCellValue(row, 1))

344 rowContents["estimate"] = str(self.grid.GetCellValue(row, 2))

345 rowContents["owner"] = str(self.grid.GetCellValue(row, 3))

346 self.plandata.editRow(row, rowContents)

347

348 def loadPlanData(self):
349 """For use when plandata has just been updated directly, usually when the user

350 has loaded a file and so the plan needs to be displayed"""

351 # NOTE TODO update so these call the findcolindex function instead of hardcoded
352 for i in range(0, self.plandata.getNumRows()):
353 rowdata = self.plandata.fetchRow(i)
354 self.grid.SetCellValue(i, 0, rowdata["milestone"])

355 self.grid.SetCellValue(i, 1, rowdata["due"])

356 self.grid.SetCellValue(i, 2, rowdata["estimate"])

357 self.grid.SetCellValue(i, 3, rowdata["owner"])

358 self.repaintRow(i)
359

360 # MAIN METHOD LOOP ====================================================================
361 if name == " main ":

362 planner = wxPySimpleApp()

363 frame = PlannerGUI(None, -1, "Dynamic Planner")

364 planner.MainLoop()
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